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注： 「注」は、コンピューターをより良く使用するために役立つ重要な
情報を意味します。
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他 )不法行為であるかを問わず、Dell、著作権保持者、協賛者は、損害が生じ

る可能性について報告を受けていたとしても、本ソフトウェアの使用から生じた直

接的、間接的、偶発的、特別的、懲罰的または結果的損害のいずれに対して

も一切責任を負いません(代替品またはサービスの提供、使用機会、データま

たは利益の損失の補償、または、業務の中断に対する補償を含む) 。

Dell Inc. の書面による許可のない複写は、いかなる形態においても厳重に禁じら

れています。

本書で使用されている商標：Dell、DELL ロゴおよびOpenManage は、Dell Inc.の

商標です。Intel Pentiumは、Intel Corporationの米国およびその他の国における登

録商標です。Microsoft、Windows、およびWindows Vistaは、米国および／または

その他の国におけるMicrosoft Corporationの商標、登録商標のいずれかで

す。Avocentは、米国およびその他の国におけるAvocent Corporationまたは系列

会社の登録商標です。Red Hat およびRed Hat Enterprise Linux は、米国および

その他の国におけるRed Hat, Inc. の登録商標です。SUSE は、Novell, Inc.の米

国およびその他の国における登録商標です。VMware はVMware, Inc.の米国お

よび／またはその他の国の管轄における登録商標または登録商標 (マーク)で

す。商標および名称の所有者またはその製品を参照するため、その他の商標お

よび商号が本書で使用されていることがあります。これらの商標や商号は、一

切Dell Inc. に所属するものではありません。
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オンライン・ヘルプの使い方
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ターナショナル)

• Webサイト：http://www.dell.com/support
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製品概要

Dell™ Remote Console Switch( RCS)ソフトウェアは、異なるプラットフォーム間で

作動する管理アプリケーションで、スイッチおよび接続されているすべてのサー

バーの表示および制御を行うことができます。異なるプラットフォーム間で作動す

る設計により、広く使用されているほとんどのオペレーティング・システムとハード

ウェアのプラットフォームとの互換性が確実になります。RCSソフトウェアでは、ス

イッチ・ベース認証、データ転送およびユーザー名／パスワードの保管が安全に

実施できます。各スイッチで認証とアクセス・コントロールが個別に取り扱われ、

システム制御の分散が効果的に行われます。

RCSソフトウェアでは、直観的な分割画面インターフェイス形式のExplorer型ナ

ビゲーション方式が使用されており、システム全体に対して単一ポイントからアク

セスできる操作性が追加されています。ユーザーはここから、システム・サーバーに

対して、既存のスイッチの管理、新規スイッチのインストール、ビデオ・セッションの

起動などを行うことができます。またサーバー、サイト、フォルダ別などの組み込み

のグループ分けにより、表示するユニットの選択が容易にできます。強力な検

索・分類機能により、いずれのユニットの検索も簡素化します。

特長とメリット

RCSソフトウェアは、簡単にインストールと操作ができるよう設計されています。管

理下にあるスイッチを自動検出する機能により、新しいユニットを数分でインス

トールすることができます。ウィザードベースのインストールとオンラインのヘルプによ

り、システムの初期設定が簡単に実施できるようになっています。直感的なグラ

フィックを利用したインターフェイスの導入により、スイッチの管理と更新は非常に

簡単で分かりやすくなっています。
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強力なカスタマイズ機能

RCSソフトウェアを調整して、システムの特定のニーズに合わせることができます。

デフォルトのグループを活用することも、またユーザー独自のグループを作成するこ

ともできます。ユニットやフィールドの名前、およびアイコンをカスタマイズして、ユー

ザーがより使いやすいように設定を変更できます。例えば、システム・ユニットは、

ユーザーが識別しやすい名称を使用すれば短時間で容易に検索できます。

Remote Console Switchの広範囲な管理機能

RCSソフトウェアを使用すると、一つのシステム内に複数のスイッチを追加し、管

理することができるようになります。新しいスイッチをインストールすると、スイッチ・

パラメーターの構成、ユーザー・ビデオ・セッションの制御、プリエンプトができるよう

になります。さらにスイッチの再起動やアップグレードなどのコントロール機能も実

行できます。RCSソフトウェアは、Dell OpenManager™ IT Assistant Event Viewer
に対応するように設計されているので、システム管理者はシステム・イベントの各

レポートを統合することができます。簡易ネットワーク管理プロトコル( SNMP)ト
ラップの有効化、ターゲット・デバイスの構成、ユーザー・データベースの管理が実

行できます。

このソフトウェアを使用して、以下のDellスイッチを管理することができます。

• 4322DS

• 2162DS

• 1082DS

• 2161DS

• 2321DS

• 4161DS

• 2161DS-2

• 1081AD

• 2161AD

注： Dell 1081ADと2161ADスイッチについては、 RCSを介して追加／管理するスイッチ
用にDellリモートアクセスキー( RAK) が必要です。
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認証および承認

RCSソフトウェアを使用すると、複数のRemote Console Switchのアクセス権を、

それぞれのRemote Console Switchで個別に管理するのではなく、単一のイン

ターフェイスで管理できます。セキュリティと効率性を向上させるため

に、Lightweight Directory Access Protocol( LDAP)機能ではネットワーク全体の

単一認証ソースからアクセス権を取得するため、個々のRemote Console Switch
でアクセス権を更新する必要がありません。

Remote Console Switchでは、標準のActive DirectoryスキーマまたはDell拡張

スキーマを使用して認証を行い、すべてのDellハードウェアとの互換性を最大限

に保つことができます。

注： Dell 1081ADおよび2161ADスイッチはLDAPをサポートしません。

システム・コンポーネント

本ソフトウェアの主要コンポーネントは、以下のとおりです。

RCS Explorerウィンドウ

RCS Explorerウィンドウは、ソフトウェア機能にアクセスする際の主要な制御を行

うウィンドウです。ローカル・データベースで定義されているスイッチやターゲット・デ

バイスは、Explorerウィンドウから参照できます。ユニットの一覧は、既定の分類

カテゴリー(アプライアンス、デバイスなど)により異なる方法で表示できます。また

新たな名称でフォルダを追加することによりカテゴリーをカスタマイズすることもでき

ます。ユニットにカスタム・フィールドを指定して他のカテゴリーを使用することもでき

ます。

Explorerのデバイス・リストでは、ターゲット・デバイス・リストからデバイスを選んで、

このデバイスとのKVMセッションを起動することができます。キーボード／ビデオ／

マウス( KVM)セッションを起動すると、ビデオ・ビューアが開きます。Explorerのアプ

ライアンス・リストでは、構成したいスイッチを選択できます。
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ビデオ・ビューア

ユーザーはこのビデオ・ビューアからターゲット・デバイスへのアクセスや管理を行い

ます。事前に定義されたマクロの中から、ビデオ・ビューアのマクロ・メニューに表示

するマクロ・グループを選択できます。Remote Console Switchでは、ビデオ・ビュー

アを開いてターゲット・デバイスに接続できます。詳細については、 「ビューアの使

用法」 (ページ 65) を参照してください。

また、ビデオ・ビューアからはバーチャル・メディア・ウィンドウにもアクセスできます。

バーチャル・メディア・ウィンドウでは、物理ドライブ(ディスク、CD-ROM、DVD-
ROMのデータ・ドライブなど)をターゲット・デバイスにマッピングできます。これによっ

て、メディア・デバイスが直接ターゲット・デバイスに接続されていない場合でもデ

バイスを使用できるようになります。バーチャル・メディア・ウィンドウに関する詳細

については、「ビューアの使用法」 (ページ 65) を参照してください。

Avocent®製品との相互運用性

RCSソフトウェアを使用して一部のアボセント製スイッチにアクセスできます。ま

た、これらのアボセント製スイッチを管理できるので、システムの管理での柔軟性

を高めることもできます。

さらに、RCSソフトウェアはAvocent IQモジュールもサポートしているため、より多く

のサーバー・タイプをアクセス、管理できます。Avocent IQモジュールのサポートが

追加されたことにより、次の接続がサポートされるようになりました。

• PS/2モジュール( Dell/Avocentモジュール経由 )

• バーチャル・メディアおよびスマート・カード／Common Access Card
( CAC)バージョンなどのUSBモジュール( Dell／Avocentモジュール経由 )

• VT100シリアル・モジュール( Avocentモジュール経由 )

• Trueシリアル・モジュール( Dell／Avocentモジュール経由 )

• Sunモジュール( Avocentモジュール経由 )

• PS2Mモジュール( Avocentモジュール経由 )

注： Dell SIPモジュールは、直接接続されているアボセント製スイッチでサポートされ
ています。

注： Dell 1081ADおよび2161ADスイッチはTrueシリアル・モジュールをサポートしません。
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操作機能

RCSソフトウェア機能には、ターゲット・デバイスの名前付け、ターゲット・デバイス

名の表示、並び替え、およびIPv4とIPv6ネットワーク・アドレス機能が含まれま

す。「キーボードとマウス」 (ページ 111) にExplorerの操作で使用するショートカッ

トが一覧されています。他のコンポーネントも、マウス操作に加えてキーボードの

フル操作に対応しています。

ターゲット・デバイスの名前付け

このソフトウェアでは、各スイッチとターゲット・デバイスで固有の名前が必要となっ

ています。データベース内の既存の名前と競合する名称に対しては、ソフトウェ

アは次の手順で固有の名前を生成し、ユーザーの介入を最小限に抑えます。

バックグラウンド処理 (名前や接続の追加・変更などの自動処理 )中に競合す

る名前が検出された場合、競合する名称は自動的に固有名に変更されま

す。これは、ティルデ (~) の後に任意の数字を加えることで行われます。数字

は、ティルデを追加しただけでは名前を固有化できない場合に追加されます。

この場合、数字は1の値から始まり、名前が固有のものになるまで増分されま

す。

操作中に固有ではない名前を指定すると、固有名を指定するよう求めるメッ

セージが該当のユーザーに表示されます。

ターゲット・デバイス名の表示

スイッチが追加されると、このスイッチから取得したターゲット・デバイス名はソフト

ウェアのデータベースに保存されます。この後、ユーザーはExplorerでターゲット・デ

バイス名を変更できます。新しい名はデータベースに保存され、様々なコンポー

ネント画面で使用されます。ターゲット・デバイスの新しい名は、スイッチには送

信されません。

このソフトウェアは分散処理型の管理システムとなっているため、スイッチ上の

ターゲット・デバイスに割り当てられた名前は、ソフトウェアのデータベースを更新

する必要なしにいつでも変更できます。管理下のターゲット・デバイスのリストは、

ユーザーごとにカスタマイズして表示することができます。
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単一のターゲット・デバイスに対して複数の名前を関連付けるため(スイッチ上で

はある名称、ソフトウェア内で別の名称、のように)、ソフトウェアでは以下の規

則に従ってどの名前を用いるかが判断されます。

• Explorerは、自己のデータベース内のターゲット・デバイスのみを、この

データベース内にある名前で一覧表示します。すなわち、ターゲット・デ

バイスの情報を得るためにExplorerがスイッチにクエリを送ることはありま

せん。

• 再同期化ウィザードは、スイッチのターゲット・デバイス名がデフォルト名

から変更された場合にのみ、ローカルで指定したターゲット・デバイス名

を上書きします。再同期化中にスイッチから読み込まれたターゲット・デ

バイスの非デフォルト名は、ローカルで指定した名前に優先します。

分類機能

ソフトウェア・コンポーネントの一部の表示形態では、各アイテムに関する情報が

複数のコラムに示されるアイテムのリストが表示されます。コラム・ヘッダーに矢印

がついている場合、このリストを表示する際は、コラムを昇順または降順に分類

して表示できます。

コラム・ヘッダーごとに表示を分類するには、コラム・ヘッダーの矢印をクリックしま

す。リスト内のアイテムはこのコラムに従って分類されます。上向き矢印は、リスト

がこのコラム・ヘッダーで昇順に配列されていることを示します。下向き矢印は、リ

ストがこのコラム・ヘッダーで降順に配列されていることを示します。

IPv4およびIPv6のネットワーク･アドレス機能

RCSソフトウェアは、現在サポートされているインターネット･プロトコル･バージョン

であるIPv4(デフォルト)またはIPv6のいずれか、またはIPv4モードとIPv6モードの

両方を同時に使用するシステムにも対応しています。

注： Dell 1081ADおよび2161ADスイッチは、 IPv4とIPv6モードの同時使用には対応して
いません。

IPv4モードの接続は、ステートフル(設定とIPアドレスをサーバーから取得する)あ
るいはステートレス(スイッチは通常、IPアドレスとルーター･アドレスをルーターから

動的に取得する)の自動設定のいずれかです。IPv4モードの場合、スイッチの
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ファームウェア・アップグレードと緊急起動ファームウェア・アップグレードは、TFTP
サーバーとFTPサーバーの両方でサポートされます。

IPv6モードはステートレスの自動設定接続です。IPv6モードの場合、スイッチの

ファームウェア・アップグレードはFTPモードのみで対応しており、緊急起動ファー

ムウェアのフラッシュ・ダウンロードは実行できません。フラッシュ・ダウンロードを行う

には、TFTPサーバーを介して一時的にIPv4ネットワークに接続する必要があり

ます。

注： Dell 1081ADおよび2161ADスイッチでは、 IPv6モードはステートフル接続です。
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設置

RCSソフトウェアをクライアント・コンピューターにインストールする前に、必要なアイ

テムがすべて揃っていること、およびターゲット・デバイスとRCSクライアント・コン

ピューターで作動しているオペレーティング・システム、ブラウザ、Java Runtime
Environmentがサポート対象のものであることを確認してください。

ソフトウェアに同梱されているアイテム

このソフトウェアは、アプライアンスのRemote Console SwitchソフトウェアCDに収

録されています。ユーザー用のマニュアルは、Remote Consoleソフトウェア

のExplorerウィンドウのヘルプ・メニューから、オプションとしてアクセスできます。

サポートされているオペレーティング・システム

RCSを稼動しているクライアント・コンピューターでは、次のいずれかのオペレーティ

ング・システム・バージョンを使用している必要があります。

• Microsoft® Windows® 2003 Server、Service Pack 3 Web、Standard、
およびEnterprise

• Microsoft Windows Server® 2008 Web、Standard、およびEnterprise

• Microsoft Windows XP Professional( Service Pack 3)

• Microsoft Windows Vista™ Business( Service Pack 1)

• Microsoft Windows 2000 Professional、Service Pack 4

• Microsoft Windows 7 Home PremiumおよびProfessional

• Red Hat® Enterprise Linux® 4.0および5.0 WS、ES、およびAS
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• SUSE® Linux Enterprise Server 10およびServer 11

• Ubuntu 8 ServerおよびWorkstation

ターゲット・デバイスでは次のいずれかのオペレーティング・システムを稼動している

必要があります。

• Microsoft Windows 2000 Server( 32-bit)およびAdvanced Server

• Microsoft Windows XP ProfessionalおよびStandard( Service Pack 3)

• Microsoft Windows Server 2003 Web、Standard、およびEnterprise

• Microsoft Windows Server 2008 Web、Standard、およびEnterprise

• Microsoft Windows Vista Standard、Business( Service Pack 1)、およ

びEnterprise

• Microsoft Windows 7 Home PremiumおよびProfessional

• Netware 6.5( 32ビット)

• Red Hat Enterprise Linux 4.0および5.0( WS、ES、およびAS)

• Solaris Sparc 10( 64ビット)

• SUSE Linux Enterprise Server 10およびServer 11

• Ubuntu 8 ServerおよびWorkstation

• VMWare® ESX 3およびESX 4( 32-bit)

ハードウェア・コンフィギュレーション要件

本ソフトウェアのシステム・ハードウェア構成の最小要件は以下のとおりです：

• 500 MHz Intel® Pentium® III

• RAM 256 MB以上

• 10または100BaseT NIC( 100推奨 )

• グラフィック・アクセラレーター付きXGA Video

• デスクトップ解像度が少なくとも800 x 600であること
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• カラーパレットが少なくとも65,536色 ( 16ビット)であること

サポートされているブラウザ

Webインターフェイスへのアクセスに使用するコンピューター、およびこのソフトウェア

を実行するクライアント・コンピューターには、次のいずれかのブラウザがインストー

ルされている必要があります。

• Microsoft Internet Explorer バージョン 6.x SP1以降

• Firefox バージョン2.0以降

JREの要件

このソフトウェアを実行しているクライアント・コンピューターを使用してターゲット・

デバイスにアクセスするコンピューターには、Java Runtime Environment (JRE)
の1.6.0_11以降のバージョンがインストールされている必要があります。スイッチ

は、該当のコンピューターにJavaがインストールされているかどうかの検出を試みま

す。Javaがインストールされていない場合は、http:// www.java.comからインストー

ルして、JNLPファイルをJava WebStartに関連付ける必要があります。

ソフトウェアのインストール

このソフトウェアは、Microsoft WindowsおよびLinuxのオペレーティング・システムに

インストールできます。対象システムにRCSソフトウェアをインストールするには、次

の手順に従います。

Microsoft Windowsシステムにインストールするには：

1 CD-ROMドライブにRCSソフトウェアのCD-ROMを挿入します。

2 次のコマンドを実行し、プログラムのインストールを開始します(「drive」を使

用のCD-ROMドライブ名の文字に置き換えてください)：

drive:\WIN32\SETUP.EXE.

3 画面上の手順に従ってください。

Linuxシステムにインストールするには：
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1 CD-ROMドライブにRCSソフトウェアのCD-ROMを挿入します。

2 AutoMountがサポートされていて有効になっている場合は、手順3に進みま

す。

-または-
システムがAutoMountをサポートしていない場合は、

次のコマンドを実行し、CD-ROMの内容をマウントします：

mount -t iso9660 -ro mode=0555 <device> <mount point>

「device」を使用マシンのCD-ROM名に置き換え、「mount point」を希

望するマウント・ポイント名に置き換えます。例えば、 /mnt上の第2 IDE
装置であるCD-ROMにマウントする場合、次のコマンドを実行します：

mount -t iso9660 -ro mode=0555 /dev/hdb /mnt

3 コマンド・ラインで、作業ディレクトリをマウント・ポイントに変更するための次

のコマンドを実行します：

cd /mnt

4 次のコマンドを実行し、プログラムのインストールを開始します：

sh ./linux/setup.bin

5 画面上の手順に従ってください。

ソフトウェアのアンインストール

Microsoft Windowsオペレーティング・システムで、このソフトウェアをアンインストー

ルするには、コントロールパネルから以下の手順で行います：

1 コントロールパネルを開き、プログラムの追加と削除を選択します。現在イン

ストールされているプログラムの一覧が表示されます。

2 RCSを選択します。

3 変更と削除ボタンをクリックします。アンインストール・ウィザードが開きます。

4 アンインストールボタンをクリックし、画面上の手順に従います。

Microsoft Windowsオペレーティング・システムで、コマンド・ウィンドウからこのソフト

ウェアをアンインストールするには、以下の手順で行います：



設置xxx | xxx19

1 コマンド・ウィンドウを開き、RCSのインストール時に使用したインストール・

ディレクトリを指定します。Windows 32ビット・オペレーティング・システムでの

デフォルト・パスは、プログラム・ファイル・ディレクトリです。

2 UninstallerDataサブディレクトリを指定し、次のコマンドを(クォーテーション・

マークも含めて)入力します：

“Uninstall Dell Remote Console Software.exe”

アンインストール・ウィザードが開きます。画面上の手順に従ってください。

Linux稼動のシステムでこのソフトウェアをアンインストールするには、以下の手順

で行います：

1 コマンド・ウィンドウを開き、RCSのインストール時に使用したインストール・

ディレクトリを指定します。Linuxシステムでのデフォルト・パスは /usr/lib です。

2 UninstallerDataサブディレクトリを指定し、次のコマンドを入力します：

% sh ./Uninstall_Dell_Remote_Console_Software

アンインストール・ウィザードが開きます。画面上の手順に従ってくださ

い。

ソフトウェアの起動

Microsoft Windowsシステムでソフトウェアを起動するには：

スタート → プログラム→ Dell RCS softwareを順に選択します。RCSソフトウェア

が起動します。

LinuxでRCSソフトウェアを起動するには：

アプリケーション・フォルダ(デフォルトでは/usr/lib/Dell_Remote_Console_Switch_
Software)から、次のコマンドを入力します。

./Dell_Remote_Console_Switch_Software

-または-

/user/binから次のリンクを入力します。

./Dell_Remote_Console_Switch_Software

-または-
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本製品がデフォルト以外のディレクトリにインストールされている場合には、次の

コマンドをシェルから実行します。

<パス>/Dell_Remote_Console_Switch_Software

-または-

インストール時にデスクトップにショートカットを作成してある場合は、ショートカット

をダブルクリックします。

スイッチとターゲット・デバイスの構成

このセクションでは、スイッチとターゲット・デバイスへのユーザー・アクセスの構成手

順の概要を説明します。スイッチに関する特定の情報については、スイッチの『イ

ンストレーション／ユーザー･ガイド』を参照してください。

スイッチを追加するには、以下の手順で行います：

1 ソフトウェアをクライアント・コンピューター( 1台または複数台 )にインストールし

ます。

2 クライアント・コンピューターでソフトウェアを起動します。

3 必要に応じてExplorerからユニット・プロパティやオプションの設定、その他のカ

スタマイズを行います。

4 ローカルGUIインターフェイスを使用してすべてのターゲット・デバイスの名前を

構成します。

5 管理対象となる各スイッチで、手順3から6を繰り返します。

6 ソフトウェアの環境設定が完了したら、File → Database → Saveを順に選

択し、ローカル・データベースのコピーをすべての設定内容とともに保存しま

す。

7 2台目のコンピューターでソフトウェアを起動し、File → Database → Loadを
順に選択して先ほど保存したファイルまで移動します。ファイルを選択

し、Loadをクリックします。セットアップ対象のクライアント・コンピューターのすべ

てでこの手順を繰り返します。
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8 スイッチに接続されているターゲット・デバイスにアクセスするには、Explorerで
ターゲット・デバイスを選択し、Connect VideoまたはBrowseボタン(表示され

るのは選択されたターゲット・デバイスに対応するボタンのみです)をクリックし

て、セッションを開始します。

ユーザー・アカウントを構成するには、RCSソフトウェアを使用するか、また

はRemote Console Switchに統合されているWebインターフェイスから行います。

詳細については、『Dell Remote Console Switchインストレーション／ユーザー･ガ

イド』を参照してください。

Remote Console Switchを構成するには、以下の手順で行います：

1 付属のシリアル・ケーブルを使用して、端末あるいは端末エミュレーション・ソ

フトウェア稼動のPCをスイッチ背面パネルの設定ポートに接続します。この

端末は、9600ボー、8ビット、1ストップ・ビット、パリティなし、フロー・コントロー

ルなしに設定してください。

2 まず付属の電源コードをスイッチの背面に接続し、それから適切な電源コン

セントに差し込みます。

3 電源スイッチを入れると、ユニット背面の電源表示ランプが30秒間点滅し、

セルフテスト実行中であることを示します。メイン・メニューにアクセスするに

は、Enterキーを押してください。

Remote Console Switchハードウェアの環境設定：

1 Mainメニューが表示されます。メニューには11のオプションがあります。オプショ

ン1のNetwork Configurationを選択します。

2 オプション1を選択し、ネットワークの速度を設定します。速度を選択して設

定すると、Network Configuration Menuに戻ります。

3 オプション2を選択し、 IP Configurationメニューを開きます。

4 以下のIPアドレス・タイプのなかから対応する番号を1つ入力して選択しま

す：1: None、2:IPv4 Static、3:IPv4 Dynamic、4：IPv6 Static、または5:IPv6
Dynamic。
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5 Terminal Applicationsメニューからオプション3～5を順に選択し、Remote
Console SwitchのIPアドレス、Netmask、Default Gatewayの構成を終了しま

す。

6 上記の手順が完了したら、 Ø キーを押してMainメニューに戻ります。

HTTPおよびHTTPSポートを構成するには：

1 Mainメニューが表示されます。メニューには11のオプションがあります。Set
Web Interface Portsのオプション番号を選択して、Web Interface Port
Configuration Menuを開きます。

2 オプション1を選択し、ポート番号を設定します。HTTPポートおよびHTTPS
ポートに使用するポート番号を入力します。

3 ネットワークに対して正しい値が表示されていれば、Yとタイプして Enterキー

を押します。

4 ローカル・ユーザー・ステーションで、ターゲット・デバイス名を入力します。

マウスの加速

リモート･ビデオ･セッション中にマウスの反応が遅くなった場合は、ターゲット・デバ

イスのオペレーティング・システムでマウスの加速を無効にし、各ターゲット・デバイ

スでのマウスの加速をSlowまたはNoneに調整します。

Webインターフェイスのインストールとセットアップ

新しいアプライアンスのインストールが完了したら、Webインターフェイスを使用し

てユニット・パラメーターを設定し、ビデオ・セッションを起動できます。

サポートされているブラウザ

Webインターフェイスでは、以下のブラウザがサポートされています：

• Microsoft Internet Explorer® version 6.x SP1以降

• Firefox バージョン2.0以降

OBWIの起動

Webインターフェイスは次の手順で起動します：
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1 Webブラウザを開き、ローカルWebインターフェイスを使用してアプライアンス

のIPアドレスを入力します。

注： シリアル･コンソールでデフォルトのHTTP/HTTPSポートを変更しており、 IPv4アドレ
スを使用している場合は、「https://<ipaddress>:<port#>」の形式でIPアドレスを入力
します。ここで、「port#」は、シリアル･コンソールで変更したポート番号となりま
す。 IPv6アドレスを使用している場合は、「https://[<ipaddress>]:<port#>」の形式でIP
アドレスを入力します。ここで、「port#」は、シリアル･コンソールで変更したポート番
号となります。 IPv6アドレスを使用している場合は、アドレスを角括弧で囲む必要が
あります。

2 ログイン・ウィンドウが開きます。ユーザー名とパスワードを入力し、OKをク

リックします。

注： デフォルトのユーザー名は「Admin」で、パスワードはなしです。

3 Webインターフェイスが開き、Connectionsタブが表示されます。

注： Webインターフェイスを使用するには、コンピューターに1.6.0_11以降のバージョン
のJava Runtime Environment( JRE) がインストールされている必要があります。KVMス
イッチは、コンピューターにJavaがインストールされているかどうかの検出を試みま
す。Javaがインストールされていない場合は、http:// www.java.comからインストール
して、JNLPファイルをJava WebStartに関連付ける必要があります。

注： Webインターフェイスにいったんログインすると、ログアウトした場合か、または管
理者が設定したアイドル・タイムアウトの時間枠を超過した場合を除き、新規セッ
ションを起動する際にログインし直す必要はありません。
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基本のソフトウェア操作

RCSソフトウェアExplorer(以降、Explorerと称します)は、本ソフトウェアの主要イ

ンターフェイス( GUI)です。このExplorerから、サポートされているユニットすべての

表示、アクセス、管理、カスタム・グループの作成を実行できます。

Explorerでのシステムの表示

ソフトウェアを起動すると、Explorerのメイン・ウィンドウが開きます。Explorerは次

のペインに分割されています：ビュー選択タブ、グループ選択ペイン、およびユニッ

ト選択ペイン。これらの領域の内容は、ターゲット・デバイスやアプライアンスが指

定されているか、またはどのタスクを実行するかにより異なります。図 3.1には、こ

れらの操作機能が示されています。

ビュー選択タブの一つをクリックし、Remote Console Switches、Servers、Sites、
およびFoldersのいずれかのカテゴリーでグループ分けされたシステムを表示しま

す。Explorerのデフォルト表示は、ユーザーによる設定が可能です。これらの4つ
のタブのいずれかを自動的に開くようにすることができます。詳細については、

「ウィンドウ表示のカスタマイズ」 (ページ 27) を参照してください。デフォルト表示

をカスタマイズしない場合、最初のRemote Console Switchが追加されていれ

ば、ExplorerはServersビューで表示されます。
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図 3.1：Explorerウィンドウ

1 メニュー・バー：RCSソフトウェアの種々の機能には、ここからアクセスします。

2 ビュー選択タブ：Explorerの表示形態を選択するためのビュー選択タブ4種が

含まれています。

3 グループ選択ペイン：現在のビュー選択タブで利用可能なグループ分けを表

すツリー構造が含まれています。Remote Console Switchesタブ、Sitesタブ、

またはFoldersタブを選択したときにユニット選択ペインに表示される内容

は、選択したグループにより決定されます。

4 ステータス・バー：ユニット・リストに表示されたユニットの数を表示します。

5 ユニット選択ペイン：選択された表示形態またはグループに対応するSearch
バー、ユニット・リスト、およびTask ボタンを含むものです。
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6 Searchバー：検索ボックスに入力したテキストに基づいてデータベースを検索

できます。

7 ユニット・リスト：現在選択されているグループに含まれるユニットのユニット・リ

スト、またはSearchバーで実行した検索の結果を表示します。

8 タスク・ボタン：実行可能なタスクのボタンが含まれています。ボタンによって

は、ユニット・リストで選択されたユニットの種類に基づいて変化するものや、

固定され、常に表示されるものがあります。

選択したスイッチでWebインターフェイスが有効になっている場合、Explorerウィン

ドウの下部にResyncとConfigure Applianceの2つの追加ボタンが表示されます。

Resyncボタンでは、電源が投入されていないSIPまたはAvocent IQモジュールを

検索できます。Configure Applianceボタンでは、Remote Console Switchをアップ

グレードできます。選択したスイッチがWebインターフェイスで有効になっていない

場合は、ResyncとConfigure Applianceのボタンは表示されません。

ウィンドウ表示のカスタマイズ

Explorerウィンドウは常時サイズ変更できます。アプリケーションを起動するたび

に、Explorerウィンドウはデフォルト設定のサイズと位置で開きます。

グループ選択ペインとユニット選択ペインは、画面を縦に走る分割ペイン・ディバ

イダーで分割されています。この2つのペインの表示領域は、ディバイダーを左右

に動かすことで変更できます。ディバイダーは、Explorerを起動するたびにデフォル

トの位置に戻ります。ディバイダー・ペインとツリー表示制御のショートカットについ

ては、「キーボードとマウス」 (ページ 111) を参照してください。

起動時にどの表示形態で立ち上げるか(アプライアンス、デバイス、サイト、また

はフォルダ)は、Explorerで自動的に選択させることも、ユーザー指定にすることも

可能です。詳細については、 「ウィンドウ表示のカスタマイズ」 (ページ 27) を参

照してください。

コラム上部の分類バーをクリックすると、ユニット・リストの順番や分類別を変更で

きます。コラムヘッダーの上向き矢印は、リストがこのフィールド名で昇順に配列

されていることを示します。下向き矢印は、リストがこのフィールド名で降順に配

列されていることを示します。



28xxx | 基本のソフトウェア操作xxx

Remote Console Switch( DellまたはAvocent) の
追加

RCSソフトウェアでは、Dell Remote Console Switchに加えて、アボセント製スイッ

チを管理することもできます。したがって、お使いのRCSソフトウェアのデータベース

にRemote Console Switchを追加するプロセスの中で、追加するスイッチのベン

ダーと製品タイプを選択するように要求されます。Remote Console Switchまたは

アボセント製スイッチが追加されると、ユニット・リストに表示されます。手動

でRemote Console Switchを追加したり、探したりすることができます。ユニット

はIPv4またはIPv6のIPアドレスで追加することができます。

割り当てたIPアドレスで新規のRemote Console Switchを追加するには：

1 ExplorerメニューからFile → New→ Remote Console Switchを順に選択し

ます。

-または-
New Remote Console Switchタスク・ボタンをクリックします。New
Remote Console Switchウィザードが表示されます。

2 Nextをクリックします。Product Typeダイアログ・ボックスが表示され、Remote
Console Switchのベンダーと製品の選択が要求されます。
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図 3.2：Product Typeダイアログ・ボックス

3 Vendorを選択します。各ベンダーについて、サポートされる製品名

がProductリストに表示されます。製品を選択します。

追加するRemote Console Switchのモデルが、Productリスト内に存在し

ない場合は、Otherを選択します。この方法で追加したスイッチは、検

出後にProductリストに追加され、Remote Console Switchを次回追加

する際にリストから選択できるようになります。

注： New Remote Console Switch Wizardの各ダイアログ・ボックスに、Productリストか
ら選択したスイッチの種類が表示されます。

4 Nextをクリックします。

5 Remote Console Switchに割り当てられたIPアドレスがあるかどうかを問うメッ

セージが表示されます。Yesをクリックした後、Nextをクリックします。
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6 Locateウィンドウが表示されます。ホスト名またはIPアドレス、HTTPポート、

およびHTTPSポートを入力し、Nextをクリックします。IPv4のアドレス

は、xxx.xxx.xxx.xxxのドット表記式で入力します。IPv6アドレスは16進数

のFD00: 172:120000000033表記または省略のFD00:172:12:33表記で入

力します。

7 RCSソフトウェアは、指定されたユニットと、電源が投入されたSIP、Avocent
IQモジュール、およびサーバー名がある場合はこれらをすべて検索します。

電源が投入されていないSIPモジュールやAvocent IQモジュールを検索する

場合は、ソフトウェアの再同期機能にアクセスし、 Include Offline SIPs
チェック・ボックスをクリックして有効にします。

8 Nextをクリックします。

9 接続されているレガシー・スイッチがRCSソフトウェアによって検出された場合

は、Configure Tiered Switchesダイアログ・ボックスが表示されます。このダイ

アログ・ボックスには、Remote Console Switchから検索された全部のSIP
EIDのリスト、さらに、ケーブルが接続されているティアド・スイッチがある場合

はそれらも含まれます。このダイアログ・ボックスの初回表示の時点では、す

べてのスイッチはNoneに設定されています。検出されたスイッチには、ドロップ

ダウン・リストの隣にアイコンが表示されます。

a. Existing Tiered Switchesフィールドには、データベースで現在定義され

ているスイッチ全部がリストされます。リストを変更する場合

は、Add、Modify、またはDeleteをクリックします。

b. スイッチに接続されているSIPモジュールまたはAvocent IQモジュールごと

に、ドロップダウン・リストから適切なスイッチを選択して関連付けます。
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図 3.3：Configure Tiered Switchesダイアログ・ボックス

10 Remote Console Switch Wizardの最後のページに到達したら、Finishをク

リックしてウィザードを終了し、メイン・ウィンドウに戻ります。使用してい

るRemote Console Switchは、この段階でユニット選択ペインの表示になりま

す。

新たなRemote Console Switchで割り当てられたIPアドレスを持たないものを追

加するには：

1 ExplorerメニューからFile → New→ Remote Console Switchを順に選択し

ます。

-または-
New Remote Console Switchタスク・ボタンをクリックします。New
Remote Console Switchウィザードが表示されます。
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2 Nextをクリックします。Product Typeダイアログ・ボックスが表示され、Remote
Console Switchのベンダーと製品の選択が要求されます。

図 3.4：Product Typeダイアログ・ボックス

3 Vendorを選択します。各ベンダーについて、サポートされる製品名が

Productリストに表示されます。製品を選択します。

追加するRemote Console Switchのモデルが、Productリスト内に存在し

ない場合は、Otherを選択します。この方法で追加したスイッチは、検

出後にProductリストに追加され、Remote Console Switchを次回追加

する際にリストから選択できるようになります。

4 Nextをクリックします。

5 Remote Console Switchに割り当てられたIPアドレスがあるかどうかを問うメッ

セージが表示されます。Noをクリックした後、Nextをクリックします。
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6 Network Addressウィンドウが表示されます。ユニットに割り当てるIPアドレ

ス、サブネット・マスク( IPv4モードの場合 )またはプレフィックス長 ( IPv6モード

の場合 )、およびゲートウェイを入力し、Nextをクリックします。IPv4のアドレス

は、xxx.xxx.xxx.xxxのドット表記式で入力します。IPv6アドレスは16進数

のFD00: 172:12000033の表記または省略のFD00:172:12:33表記で入力し

ます。

注： Remote Console Switchは、動的ホスト構成プロトコル( DHCP) および静的IPア
ドレスをサポートしています。Dellでは、 IPアドレスをユニット毎に指定しておくこと、さ
らにRemote Console Switchユニットがネットワークに接続されている間はアドレスを静
的にしておくことをお薦めします。

7 Select Remote Console Switchウィンドウが表示され、検出された新し

いRemote Console Switchのリストから追加するユニットを選択するように求

めるメッセージが表示されます。製品を選択し、Nextをクリックします。

8 Configuring Remote Console Switchウィンドウが現れ、IP情報が正しく設

定されたかどうかが表示されます。構成が正しく実行された場合、ソフトウェ

アは新しいRemote Console SwitchおよびすべてのSIP、Avocent IQモジュー

ルと、新しいRCSに対応するサーバー名を検索します。Nextをクリックしま

す。

9 接続されているレガシー・スイッチがソフトウェアによって検出された場合

は、Configure Tiered Switchesダイアログ・ボックスが表示されます。このダイ

アログ・ボックスには、Remote Console Switchから検索されたSIPおよ

びAvocent IQモジュールのすべてのEIDと、SIPとAvocent AVRIQに接続され

ているティアド・スイッチがある場合はそのスイッチのリストが表示されます。

a. Existing Tiered Switchesフィールドには、データベースで現在定義され

ているスイッチ全部がリストされます。リストは追加、削除または変更が

できます。

b. スイッチに接続されているSIPモジュールまたはAvocent IQモジュールごと

に、ドロップダウン・リストから適切なスイッチを選択して関連付けます。
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図 3.5：Configure Tiered Switchesダイアログ・ボックス

10 完了したらFinishをクリックしてウィザードを終了し、メイン・ウィンドウに戻りま

す。使用中のRemote Console Switchは、この時点でユニット選択ペイン内

に表示されるはずです。

Remote Console Switchを見つけるには：

1 ソフトウェアのExplorerメニューから、Tools → Discoverを順に選択しま

す。Discover Wizardが表示されます。Nextをクリックします。

2 Address Rangeページが表示されます。次の手順のいずれかを実行します：

Pv4モードを使用している場合は、Use IPv4 address rangeを選択し、

ネットワーク上で検索するIPアドレスの範囲をTo AddressとFrom
Addressの各欄に入力します。IPv4のアドレスは、xxx.xxx.xxx.xxxのドット

表記式で入力します。

-または-
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Pv6モードを使用している場合は、Use IPv6 address rangeを選択し、

ネットワーク上で検索するIPアドレスの範囲をTo AddressとFrom
Addressの各欄に入力します。IPv6アドレスは16進数のFD00:
172:120000000033表記または省略のFD00:172:12:33表記で入力しま

す。

3 Remote Console Switchがシリアル・コンソールでデフォルト設定から変更され

ている場合には、HTTPとHTTPSのデフォルトのポート番号も変更できま

す。これには、新しいポート番号をHTTP PortとHTTPS Portのフィールドに入

力します。Nextをクリックします。

4 Searching Networkという進行状態を示すバーが表示されます。進行状態

を示すテキストに、範囲指定された合計数のうち何個のアドレスが検索さ

れたかが示され、また見つかったRemote Console Switchの数、またはアボセ

ント製スイッチの数が示されます。1台またはそれ以上の新しいRemote
Console SwitchまたはAvocentスイッチが検索されると、ウィザードは「Select
Remote Console Switches to Add」のページを表示します。このページから、

ローカル・データベースに追加するRemote Console Switchを選択できます。

-または-
新しいRemote Console Switchが見つからない場合 (またはStopをク

リックした場合 )は、WizardによってNo New Remote Console Switches
Foundページが表示されるので、手動でスイッチを追加する必要がありま

す。詳細については、この前の手順説明を参照してください。

5 追加するRemote Console Switchをクリックし、Add(>)ボタンをクリックして、

選択項目をRemote Console Switches to Addリストに移動します。
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図 3.6：Select Remote Console Switches to Addダイアログ・ボックス

6 追加するRemote Console Switchのすべてについて手順5を繰り返しま

す。Nextをクリックします。

7 新しいスイッチが追加される間、Adding Remote Console Switchesという進

行状態を示すバーが表示されます。選択されたスイッチがすべてローカル・

データベースに追加されると、Discover Wizard Completedページが表示され

ます。Finishをクリックしてウィザードを終了し、メイン・ウィンドウに戻ります。

新しいスイッチはこの時点でユニット選択ペインに含まれているはずです。

8 何らかの理由で(追加プロセスの間にStopをクリックした場合を含め) 1つまた

は複数のスイッチがローカル・データベースに追加できなかった場合

は、Discover Wizard Not All Remote Console Switches Addedページが表

示されます。このページには、選択したスイッチ全部とそれぞれのステータスが

リストされます。ステータスで、Remote Console Switchがローカル・データベー
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スに追加された場合はその旨が、されなかった場合には行われなかった理

由が表示されます。リストの参照が終わったら、Doneをクリックします。

注： 同一のIPアドレスを持つRemote Console Switchがユニット検出時にデータベー
スに存在する場合には、検出されたスイッチは無視され、次のウィザード・ページ上
には表示されません。

Remote Console Switchのアクセス

ソフトウェアのRemote Console Switchesタブをクリックすると、ローカル・データベー

スで現在定義されているスイッチのリストが表示されます。Remote Console
Switchにアクセスするには、まずユーザー名とパスワードを入力してログインしなけ

ればなりません。デフォルトのユーザー名は、パスワードなしのAdmin(大文字と

小文字の区別あり)です。特定のRemote Console Switchにログインすると、ソフ

トウェアのセッションの間、ソフトウェアはユーザー名とパスワードをメモリーのキャッ

シュに保存します。

注： ログイン・アカウント情報をクリアして別のユーザー名とパスワードで再ログインす
る場合は、Tools→Clear Login Credentialsを順に選択します。
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図 3.7：Remote Console Switchのビュー・タブが選択された状態

Remote Console Switchへログインするには：

1 ExplorerでRemote Console Switchesタブをクリックします。

2 ユニット選択ペインのRemote Console Switchesをダブルクリックします。

-または-
ユニット選択ペインでRemote Console Switchesを選択し、Configure
Remote Console Switchタスク・ボタンをクリックします。

-または-
ユニット選択ペインのRemote Console Switchesを右クリックします。ポッ

プアップ・メニューが表示されます。Configure Remote Console Switches
を選択します。

-または-
ユニット選択ペインのRemote Console Switchをクリックして、Enterキーを

押します。
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3 利用できる場合は、キャッシュに保存されているログイン・アカウント情報が

使用されます。利用できない場合は、ログイン・プロンプトが表示されます。

ユーザー名とパスワードを入力します。今回がRemote Console Switchへの

最初のアクセスである場合、またはユーザー名とパスワードが割り当てられて

いない場合は、デフォルトのユーザー名であるAdmin(大文字と小文字を区

別 )をパスワードなしで入力します。

4 OKをクリックして、Remote Console Switchにアクセスします。これによ

り、OBWIが起動します。OBWIの詳細については、『Remote Console
Switchインストレーション／ユーザー･ガイド』を参照してください。

-または-
Cancelをクリックして、ログインせずに終了します。

システム内でRemote Console Switchを検索するには：

1 ソフトウェアでRemote Console Switchタブをクリックし、検索テキスト・ボックス

にカーソルを置きます。

2 検索情報を入力します。この情報には、Remote Console Switchの名前ま

たは他のユニット選択リストの見出しに入力した情報 (Type、Location、IP
アドレスなど)が使用できます。

3 Searchボタンをクリックします。結果はユニット・リストに表示されます。

4 検索の結果を参照します。

-または-
Clear Resultsボタンをクリックし、リスト全体をもう一度表示します。

VNCまたはRDPビューアの起動

RCSソフトウェアは、ユーザー定義のVirtual Network Computing( VNC)およ

びRemote Desktop Protocol( RDP)のビューアをサポートしています。VNCまた

はRDPビューアを起動するには、RCSソフトウェアのExplorerからServerタブを選

択します。ユニット・リストからサーバーを選択し、画面の右下にあるVNCまた

はRDPボタンをクリックします。
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注： 「VNC」ボタンおよび「RDP」ボタンは、サーバーでリンクが設定されている場合に
のみ表示されます。詳細については、VNCとRDPのプロパティとオプションのセクション
を参照してください。

サーバーとスイッチのプロパティの変更

Remote Console Switchでは、General、Network、Information、Connectionsと
いったサーバーやスイッチのプロパティを、Propertiesダイアログ・ボックスで個別に

変更できます。General、Network、 Information 、および選択されたユニットがデ

バイスである場合にはConnectionsのタブがあり、ビューア･アプリケーションに

はVNC とRDPのタブがあります。

一般プロパティ

Generalタブでは、Remote Console Switchや接続されているサーバーの名前と表

示アイコンを変更できます。スイッチやサーバーを、特定のサイトやロケーション、

またはフォルダに割り当てることもできます。さらにサーバーについては、種類を変

更することもできます。

一般プロパティを変更するには：

1 ソフトウェアでRemote Console SwitchesタブまたはServersタブをクリックし、

ユニット選択リストからユニットを1つ選択します。

2 ExplorerメニューからView→ Propertiesを順に選択します。

-または-
Propertiesタスク・ボタンをクリックします。

-または-
ユニットを右クリックして、Propertiesを選択します。Propertiesダイアロ

グ・ボックスが表示されます。
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図 3.8：サーバーのGeneral Propertiesタブ

3 ユニットの名前を入力します。既存名と同一の名称は使用できません。

4 (オプション：サーバーのみ)サーバーの種類を選択します。ドロップダウン・リス

ト内に選択項目がない場合、テキスト・フィールドに新しいサーバーの種類

の名称を入力します。一度入力されると、それ以降の割り当てのドロップダ

ウン・リストで、このオプションが使用できるようになります。

5 このユニットを表すアイコンを選択します。

6 (オプション)ユニットをサイト、部門、またはロケーションに割り当てます。オプ

ションがドロップダウン・リストにない場合は、テキスト・フィールドに新規の割り

当て名を入力します。一度入力されると、それ以降の割り当てのドロップダ

ウン・リストで、このオプションが使用できるようになります。

7 Applyをクリックして、新しい設定を保存します。



42xxx | 基本のソフトウェア操作xxx

-または-
OKをクリックして新しい設定を保存し、Propertiesウィンドウを閉じます。

-または-
Cancelをクリックして、新しい設定を保存せずに終了します。

サーバーのネットワーク・プロパティ

Networkタブでは、ビューア・セッションを起動せずに、サーバーのWebサーバーにブ

ラウザを起動する場合の、サーバーのブラウザURLを設定できます。

ネットワーク・プロパティを変更するには：

1 ソフトウェアでServersタブをクリックした後で、ユニット選択リストからサーバー

を1つ選択します。

2 ExplorerメニューからView→ Propertiesを順に選択します。

-または-
Propertiesタスク・ボタンをクリックします。

-または-
ユニットを右クリックして、Propertiesを選択します。Propertiesダイアロ

グ・ボックスが表示されます。

3 Networkタブをクリックして、ブラウザでサーバーに接続する際に使用す

るURLを入力します。フィールドに値が含まれている場合には、タスク・バー

にBrowseボタンが表示され、指定されたURLに対するブラウザを立ち上げる

ことができるようになります。

4 Applyをクリックして、新しい設定を保存します。

-または-
OKをクリックして新しい設定を保存し、ウィンドウを閉じます。

-または-
Cancelをクリックして、新しい設定を保存せずに終了します。
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スイッチのネットワーク・プロパティ

ネットワークの再構成を行う場合は、NetworkタブでスイッチのIPアドレスを変更

できます。

ネットワーク・プロパティを変更するには：

1 ソフトウェアで Remote Console Switches タブをクリックした後で、ユニット選

択リストからユニットを1つ選択します。

2 ExplorerメニューからView→ Propertiesを順に選択します。

-または-
Propertiesタスク・ボタンをクリックします。

-または-
ユニットを右クリックして、Propertiesを選択します。Propertiesダイアロ

グ・ボックスが表示されます。

3 Networkタブをクリックして、Remote Console Switchのアドレスを入力しま

す。このフィールドには、IPドット表記やドメイン名も入力できます。既に使

用されているアドレスは使用できません。またフィールドは空欄のままにするこ

とはできません。最高で128文字を入力でき、IPv4またはIPv6アドレスのどち

らも使用できます。または、IPv4とIPv6を同時にデュアルスタックできます。

注： Dell 1081ADおよび2161ADスイッチは、 IPv4とIPv6モードの同時使用には対応して
いません。

4 シリアル・コンソールでRemote Console Switchのポート番号を変更した場合

は、HTTPおよびHTTPSのポート番号をHTTP PortとHTTPS Portのフィールド

にそれぞれ入力します。シリアル・コンソールでのポート番号の変更について

は、「HTTP/HTTPSオプション」(ページ 26)を参照してください。

5 Applyをクリックして、新しい設定を保存します。

-または-
OKをクリックして新しい設定を保存し、ウィンドウを閉じます。

-または-
Cancelをクリックして、新しい設定を保存せずに終了します。
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情報プロパティ

Informationタブでは、説明、連絡先情報や追加コメントなどのスイッチやサー

バーに関連した情報を入力できます。

情報プロパティを変更するには：

1 ソフトウェアでRemote Console SwitchesタブまたはServersタブをクリックし、

ユニット選択リストからユニットを1つ選択します。

2 ExplorerメニューからView→ Propertiesを順に選択します。

-または-
Propertiesタスク・ボタンをクリックします。

-または-
ユニットを右クリックして、Propertiesを選択します。Propertiesダイアロ

グ・ボックスが表示されます。

3 (オプション) Informationタブをクリックし、ユニットの説明を入力します。下記

のフィールドには任意の情報を保存できます。

a. Descriptionフィールドには、0～128文字の説明を入力します。

b. Contactには、0～128文字の連絡先情報を入力します。

c. Contact Phone Numberフィールドには、0～64文字の連絡先電話番

号を入力します。

d. Commentsフィールドには、0～256文字のコメントを入力します。

4 Applyをクリックして、新しい設定を保存します。

-または-
OKをクリックして新しい設定を保存し、ウィンドウを閉じます。

-または-
Cancelをクリックして、新しい設定を保存せずに終了します。
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サーバーの接続プロパティ

Connectionsタブには、選択したサーバーへのアクセスに使用される物理接続パ

スと、ビデオなどの接続のタイプが表示されます。

接続プロパティを表示するには：

1 ソフトウェアでServersタブをクリックした後で、ユニット選択リストからサーバー

を1つ選択します。

2 ExplorerメニューからView→ Propertiesを順に選択します。

-または-
Propertiesタスク・ボタンをクリックします。

-または-
サーバーを右クリックして、Propertiesを選択します。Propertiesダイアロ

グ・ボックスが表示されます。

3 Connectionsタブをクリックし、サーバーの接続を表示します。「接続」プロパ

ティは、サーバーのみが利用でき、読み取り専用です。このデバイスへのアク

セスに使用される物理的接続パスと、ビデオなどの接続の種類が表示され

ます。

4 プロパティを確認したら、OKまたはCancelをクリックしてウィンドウを閉じます。

VNCプロパティ

ユーザー指定のVNCアプリケーションを指定する場合、コマンド・ライン引数を含

めることができます。コマンド・ラインの配置についてマクロを選択できます。これ

は、IPアドレス、ポート番号、ユーザー名、パスワードなどの変数を自動置換す

る場合に便利です。Windows、Linux、およびUNIX R オペレーティング・システム

が動作するコンピューター用の独自のGUIを持たないVNCコマンドの場合、OS
のコマンド・ウィンドウからVNCアプリケーションを起動させることができます。

VNCプロパティを変更するには：

1 ユニット・リストからサーバーを選択します。

2 Remote Console SwitchのExplorerメニューからView→ Propertiesを順に選

択します。
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-または-
Propertiesタスク・ボタンをクリックします。

-または-
ユニットを右クリックします。ポップアップ・メニューからPropertiesを選択し

ます。Propertiesダイアログ・ボックスが表示されます。

3 VNCタブをクリックします。

4 サーバーの場合のみ、IPアドレス･フィールドに、IPアドレス(ドット表記法 )ま
たはドメイン名 ( 1～128文字 )を入力します。スペースは使用できません。

重複したアドレスも使用できます。IPv4およびIPv6のアドレスを使用できま

す。

5 Portフィールドにポート番号 ( 23～65535)を入力します。空欄の場合はポー

ト23が使用されます。

6 Use Defaultチェック・ボックスを有効 (チェック印をつける)または無効 (チェック

印を外す)にします。この設定が有効になっている場合、Optionsで指定さ

れたデフォルトのグローバル設定が使用され、Application to Launch領域の

他の部分はすべて無効になります。

7 ディレクトリ・パスおよび名前を入力するか、Browse ボタンをクリックしてパスと

名前を指定します。

8 パスおよび名前の下のボックスに、コマンド・ライン引数を入力します。

-または-
コマンド・ラインのカーソル位置に事前定義されたマクロを挿入するに

は、 Insert Macro リスト・ボックスをクリックして、ドロップダウン・メニューか

らマクロを選択します。RCSソフトウェアは、アプリケーションの実行時にこ

れらの変数を自動的に置換します。

9 Launch in command windowチェック・ボックスを有効または無効にします。

有効になっている場合、ユーザー指定のVNCアプリケーションがOSのコマン

ド・ウィンドウから起動します。

10 OKをクリックします。
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RDPプロパティ

ユーザー指定のRDPアプリケーションを指定する場合、コマンド・ライン引数を含

めることができます。コマンド・ラインの配置についてマクロを選択できます。これ

は、IPアドレス、ポート番号、ユーザー名、パスワードなどの変数を自動置換す

る場合に便利です。Windows、Linux、およびUNIX® オペレーティング・システム

が動作するコンピューター用の独自のGUIを持たないRDPコマンドの場合、OSの
コマンド・ウィンドウからRDPアプリケーションを起動させることができます。

RDPプロパティを変更するには：

1 ユニット・リストからサーバーを選択します。

2 Remote Console SwitchのExplorerメニューからView→ Propertiesを順に選

択します。

-または-
Propertiesタスク・ボタンをクリックします。

-または-
ユニットを右クリックします。ポップアップ・メニューからPropertiesを選択し

ます。Propertiesダイアログ・ボックスが表示されます。

3 必要に応じてRDPタブをクリックします。

4 サーバーの場合のみ、IPアドレス･フィールドに、IPアドレス(ドット表記法 )ま
たはドメイン名 ( 1～128文字 )を入力します。スペースは使用できません。

重複したアドレスも使用できます。IPv4アドレスまたはIPv6アドレスを使用で

きます。または、IPv4とIPv6のアドレスを同時に使用できます。

注： Dell 1081ADおよび2161ADスイッチは、 IPv4とIPv6モードの同時使用には対応して
いません。

5 Portフィールドにポート番号 ( 23～65535)を入力します。空欄の場合はポー

ト23が使用されます。

6 Use Defaultチェック・ボックスを有効 (チェック印をつける)または無効 (チェック

印を外す)にします。この設定が有効になっている場合、Optionsで指定さ

れたデフォルトのグローバル設定が使用され、Application to Launch領域の

他の部分はすべて無効になります。
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7 ディレクトリ・パスおよび名前を入力するか、Browseボタンをクリックしてパスと

名前を指定します。

8 パスおよび名前の下のボックスに、コマンド・ライン引数を入力します。

-または-
コマンド・ラインのカーソル位置に事前定義されたマクロを挿入するに

は、 Insert Macroリスト・ボックスをクリックして、ドロップダウン・メニューから

マクロを選択します。RCSソフトウェアは、アプリケーションの実行時にこ

れらの変数を自動的に置換します。

9 Launch in command windowチェック・ボックスを有効または無効にします。

有効になっている場合、ユーザー指定のRDPアプリケーションがOSのコマン

ド・ウィンドウから起動します。

10 OKをクリックします。

ブラウザ・ウィンドウを介したサーバーへのアクセス

必要に応じて、Webブラウザでサーバーに接続するようにソフトウェアを構成でき

ます。まずサーバーを選択し、Propertiesダイアログ・ボックスでそのサーバー

のWebサーバー・ネットワークを設定します。その後は、サーバーを選択する

と、Browseタスク・ボタンが表示されます。

注： ExplorerのOptionsダイアログ・ボックスで使用するブラウザを選択することができま
す。

注： ブラウザではどのURLにも接続できますが、サーバーに対するBrowser Networkプ
ロパティが設定されている場合、この機能はサービス・プロセッサー管理インターフェ
イス( integrated Dell Remote Access Card (iDRAC)など) で設定したサーバーに特に
適切となります。

ブラウザ・ウィンドウでサーバー・ネットワークを起動するには：

1 ソフトウェアのユニット選択ペインでサーバーを選択します。

2 このサーバーのネットワークのブラウザURLをPropertiesダイアログ・ボックスで

定義している場合は、Browseタスク・ボタンが表示されます。Browseタスク・

ボタンをクリックします。確認したURLがブラウザ・ウィンドウで開きます。
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サーバーとスイッチのオプションの変更

RCSソフトウェアのOptionsダイアログ・ボックスから、General、HTTP/HTTPS
Ports、VNC、およびRDPなどのサーバーやスイッチのオプションを個別に変更でき

ます。

一般オプション

カスタム・フィールド・ラベルを変更するには：

1 ExplorerメニューからTools → Optionsを順に選択します。Optionsダイアログ・

ボックスが表示されます。

図 3.9：Optionsダイアログ・ボックスのカスタム・フィールド・ラベル

2 変更するフィールド・ラベルを選択し、Modifyボタンをクリックします。Modify
Custom Field Labelダイアログ・ボックスが表示されます。

3 このフィールドラベルを単数形と複数形で入力します。有効な文字長

は、1～32文字です。空欄にすることはできません。スペースの使用は中間

では構いませんが、最初と最後には使用できません。
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4 OKをクリックして、新しいフィールド・ラベルを保存します。

-または-
Cancelをクリックして変更を保存せずに終了します。

デフォルト・ブラウザ

ブラウザ・オプションでは、URLが指定されているターゲット・デバイスのBrowseボタ

ンをクリックしたとき、またはRCSオンライン・ヘルプにアクセスしたときに起動するブ

ラウザを指定します。現在のコンピューターでのデフォルト・ブラウザをオンにする

か、または利用可能な他のブラウザから選んでください。

デフォルト・ブラウザの表示または変更は、以下の手順で行います：

1 ExplorerメニューからTools → Optionsを順に選択します。「一般オプション」

ウィンドウが開きます。

2 次の手順のいずれかを実行します：

• Browserフィールドで、Launch Default Browserチェック・ボックスを選択し

てデフォルトのブラウザを指定します。

• Launch Default Browserチェック・ボックスの選択を解除します。Browse
ボタンをクリックし、このコンピューターで使用できるブラウザを選択しま

す。また、使用可能なブラウザのフル・パスを入力することもできます。

3 次の手順のいずれかを実行します：

• 別のタブをクリックして異なるプロパティの変更を行います。

• 完了したら、OKをクリックして、新しい設定を保存します。

• Cancelをクリックして、新しい設定を保存せずに終了します。

DirectDrawサポートの変更 ( Windows OSのみ)

このソフトウェアはDirectDrawをサポートしています。DirectDrawは、ビデオ表示メ

モリー、ハードウェア・オーバーレイ、およびページ・フリッピングを、グラフィカル・デバ

イス・インターフェイス( GDI)を介さず、直接操作できるようにする規格で

す。DirectDrawを採用することで、よりスムーズなアニメーションや、動画・画像

ディスプレイの多いソフトウェアでのよりよい性能が得られます。
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ただし、使用機器でソフトウェア・カーソルやポインターのシャドー機能を有効にし

ている場合や、ビデオ・ドライバーがDirectDrawをサポートしていない場合には、

ビューアのタイトル・バー上にマウスカーソルを合わせた時にフリッカー(点滅 )現象

が起きることがあります。

ソフトウェアのカーソルまたはポインター・シャドウを無効にするか、ビデオ・カードに

新しいドライバーを読み込む、またはDirectDrawを無効にすることもできます。

DirectDrawを無効にするには：

1 ExplorerメニューからTools → Optionsを順に選択します。Optionsダイアログ・

ボックスが表示されます。

2 DirectDrawチェックボックスをクリックして無効にします。

3 OKをクリックします。

注： DirectDrawチェックボックスは、Windowsベースのオペレーティング・システムの場
合にのみ表示されます。

HTTP/HTTPSオプション

Remote Console Switchとソフトウェアでは、ポート80をデフォルトのHTTPポート

に、ポート443をデフォルトのHTTPSポートとして使用します。デフォルト・ポート番

号は、Optionsダイアログ・ボックスのHTTP/HTTPS Portsタブで変更できます。

1 ExplorerメニューからTools → Optionsを順に選択します。Optionsダイアログ・

ボックスが表示されます。

2 HTTP/HTTPS Portsタブをクリックします。

3 HTTPおよびHTTPSポートの新しいデフォルト・ポート番号を入力します。

4 OKをクリックします。

VNCオプション

このソフトウェアは、プロパティ・ページを介してユーザー定義のVNCビューアをサ

ポートしています。VNCタブではユーザー指定のVNCアプリケーションを検索でき

ます。そのコマンド・ライン引数を含めることもできます。コマンド・ラインの配置に

ついてマクロを選択できます。これは、IPアドレス、ポート番号、ユーザー名、パス
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ワードなどの変数を自動置換する場合に便利です。標準のWindows、Linux、
およびUNIX用の独自のGUIを持たないVNCコマンドの場合、OSのコマンド・ウィ

ンドウからVNCアプリケーションを起動させることができます。

VNCオプションを変更するには：

1 ExplorerメニューからTools → Optionsを順に選択します。Optionsダイアログ・

ボックスが表示されます。

2 VNCタブをクリックします。

3 Application to Launchフィールドに、ディレクトリ・パスおよび名前を入力する

か、Browseボタンをクリックしてパスと名前を指定します。

4 パスおよび名前の下のボックスに、コマンド・ライン引数を入力します。

-または-
コマンド・ラインのカーソル位置に事前定義されたマクロを挿入するに

は、 Insert Macroリスト・ボックスをクリックして、ドロップダウン・メニューから

マクロを選択します。RCSソフトウェアは、アプリケーションの実行時にこ

れらの変数を自動的に置換します。

5 Launch in command windowチェック・ボックスを有効または無効にします。

有効になっている場合、ユーザー指定のVNCアプリケーションがOSのコマン

ド・ウィンドウから起動します。

6 OKをクリックします。

RDPオプション

このソフトウェアは、プロパティ・ページを介してユーザー定義のRDPビューアをサ

ポートしています。RDPタブではユーザー指定のRDPアプリケーションを検索でき

ます。そのコマンド・ライン引数を含めることもできます。コマンド・ラインの配置に

ついてマクロを選択できます。これは、IPアドレス、ポート番号、ユーザー名、パス

ワードなどの変数を自動置換する場合に便利です。標準のWindows、Linux、
およびUNIX用の独自のGUIを持たないRDPコマンドの場合、OSのコマンド・ウィ

ンドウからRDPアプリケーションを起動させることができます。

RDPオプションを変更するには：

1 Explorerメニューで、Optionsダイアログ・ボックスが表示されます。
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2 RDPタブをクリックします。

3 Application to Launchフィールドに、ディレクトリ・パスおよび名前を入力する

か、Browseボタンをクリックしてパスと名前を指定します。

4 パスおよび名前の下のボックスに、コマンド・ライン引数を入力します。

-または-
コマンド・ラインのカーソル位置に事前定義されたマクロを挿入するに

は、 Insert Macroリスト・ボックスをクリックして、ドロップダウン・メニューから

マクロを選択します。RCSソフトウェアは、アプリケーションの実行時にこ

れらの変数を自動的に置換します。

5 Launch in command windowチェック・ボックスを有効または無効にします。

有効になっている場合、ユーザー指定のRDPアプリケーションがOSのコマン

ド・ウィンドウから起動します。

6 OKをクリックします。

使用システムの編成

RCSソフトウェアでSitesおよびFoldersの表示タブを使用すると、Remote Console
Switchとサーバーをカスタム・グループ別に編成し、管理できます。サイトの整理

方法はサーバーが配置されている場所に基づき、コラムヘッダーであるSite
とDepartmentとして表示されますが、これらはニーズに合わせてカスタマイズできま

す。「カスタム・フィールド名の変更」 (ページ 54) を参照してください。フォルダを

使用することで、個々のサーバー用に、カスタマイズした編成システムを作成する

ことができます。例えば、重要なサーバーやリモートサーバー用のフォルダを作成

することなどができます。

コラム・ヘッダーをクリックすると、ユニット選択リストの順番や分類別を変更できま

す。コラムヘッダーの上向き矢印は、リストがこのフィールド名で昇順に配列され

ていることを示します。下向き矢印は、リストがこのフィールド名で降順に配列さ

れていることを示します。

コラムヘッダーはカスタマイズすることができます。図 3.10は、フィールド名のデフォ

ルト値の使い方の例を示しています。これらは組織に合わせて変更できます。

図 3.11に、カスタマイズされたフィールド名の例を示します。
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図 3.10：Sitesのビュー選択タブが選択された状態

カスタム・フィールド名の変更

カスタム・フィールド名を使用すると、ソフトウェアのグループ選択ペインやユニット

選択ペインに表示されるSite、Department、およびLocationの各コラム・ヘッダー

名を変更できます。これにより、ユーザーが使いやすい形でRemote Console
Switchとサーバーのグループ分けができるようになります。Departmentフィールド

は、Siteのサブセットです。これらのフィード名をカスタマイズする場合は、この階層

構造に留意して行ってください。
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図 3.11：変更したカスタム・フィールドの例

新しいサイト、部門、またはロケーションを作成するには：

1 ExplorerメニューからView→ Propertiesを順に選択します。

-または-
Propertiesタスク・ボタンをクリックします。Propertiesダイアログ・ボックスが

表示されます。

2 Generalタブをクリックし、ドロップダウン・リストからSite、Department、また

はLocationを選択します。名前がドロップダウン・リストにない場合は、テキス

ト・フィールドに希望する名前を入力します。名前は1～32文字の範囲で

指定します。名前にはキーボードから入力できる文字を任意に組み合わせ

て使用できます。また大文字と小文字の区別はありません。スペースの使

用は中間では構いませんが、最初と最後には使用できません。既存名と

同一の名称は使用できません。

3 OKをクリックします。新しいサイト、部門またはロケーションがグループ選択ペ

インに表示されます。

フォルダの作成

新しいフォルダを作成するには：

1 Foldersのビュー選択タブを選択します。

2 Foldersノード上でクリックし、File → New→ Folderを順に選択します。

-または-
Foldersノードを右クリックし、New Folderを選択します。New Folderダイ

アログ・ボックスが表示されます。
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3 フォルダ名を1～32文字の範囲で指定します。フォルダ名にはキーボードか

ら入力できる文字を任意に組み合わせて使用できます。また大文字と小

文字の区別はありません。スペースの使用は中間では構いませんが、最初

と最後には使用できません。同じレベルでは同一のフォルダ名は使用できま

せんが、異なるレベル間では使用可能です。

4 OKをクリックします。新しいフォルダがグループ選択ペインに表示されます。

ユニットのサイト、ロケーション、またはフォルダへの割当

ソフトウェアで、Site、Department、LocationまたはFolderにRemote Console
Switchまたはサーバーを割り当てることができます。このメニュー項目は、ユニット

選択ペイン内で単一のRemote Console Switchまたはサーバーが選択されてい

るときのみに有効となります。これらのカスタム・ターゲットは、General Properties
ダイアログ・ボックスで定義されています。

ユニットをサイト、ロケーション、またはフォルダへ割り当てるには：

1 ユニット選択ペインでユニットを選択します。

2 ExplorerメニューからEdit → Assignを順に選択します。

-または-
Assign Toタスク・ボタンをクリックします。

-または-
ユニットを右クリックしてAssign Toを選択します。Assign Toダイアログ・

ボックスが表示されます。

3 サイト、ロケーションまたはフォルダ・カテゴリーをドロップダウン・リストから選択

します。

4 選択されたカテゴリーの範囲内で、使用可能なターゲットのリストから、ユ

ニットを割り当てられるターゲットを選択します。サイト、ロケーション、または

フォルダがローカル・データベース内で定義されていない場合には、このリスト

は空欄になります。

5 OKをクリックして割当を保存します。

-または-
Cancelをクリックして変更を保存せずに終了します。
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ユニットをサイト、部門、ロケーション、またはフォルダにドラッグ・アンド・ドロップす

るには：

1 ソフトウェアのユニット・リスト内でユニットをクリックし、マウスをそのまま保持し

ます。

2 このユニットを、グループ選択ペインのツリー表示内にあるノードにドラッグしま

す。

3 マウス・ボタンを放します。そのノードをクリックすると、この項目がユニット・リス

トに表示されます。

注： ユニットは、すべての部門、すべてのユニット、またはサイトのルート・ノードには
移動できません。ユニットは一度に一つずつしか移動できません。

削除および名前の変更

削除機能は、ソフトウェアのグループ選択ペインとユニット選択ペインでの現在の

選択内容に基づく状況依存型の機能です。ユニット・リストのユニットを選択し

て削除すると、ユニットはローカル・データベースから削除されます。グループ選択

ペインのツリー表示で項目を選択し削除する場合、Server
Types、Sites、Departments、およびFoldersも削除されます。ただし、いずれの操

作を行っても、ユニットはローカル・データベースからは削除されません。

名前の変更機能も状況依存型です。ユニット・リストからRemote Console
Switchまたはサーバーを選択し、名前を変更することができます。グループ選択

ペインのツリー表示でも、サーバーの種類、サイト、部門およびフォルダ名を選択

して名前を変更することができます。

Remote Console Switchまたはサーバーを削除するには：

1 ユニット選択ペインから削除するユニットを選択します。

2 Edit → Delete を順に選択します。

-または-
キーボードのDelキーを押します。削除するユニットの数の確認を求める

ダイアログ・ボックスが現れます。Remote Console Switchを削除する場

合、ダイアログ・ボックスにDelete Associated Serversチェックボックスが表
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示されます。必要に応じ、チェックボックスをクリックして有効／無効にし

ます。

3 Yesをクリックして削除を確認します。設定によっては、この他にも別のメッ

セージが表示される場合があります。該当する場合は対応してくださ

い。Remote Console Switchまたはサーバーが削除されます。

-または-
Noをクリックしてキャンセルします。

サーバーの種類、サイト、部門またはフォルダを削除するには：

1 グループ選択ペインから削除するサーバー・タイプ、サイト、部門またはフォル

ダを選択します。

2 Edit → Delete を順に選択します。

-または-
キーボードのDelキーを押します。削除されるユニットの数の確認を求め

るダイアログ・ボックスが現れます。

3 Yesをクリックして削除を確認します。設定によっては、この他にも別のメッ

セージが表示される場合があります。該当する場合は対応してください。ア

イテムが削除されます。

-または-
Noをクリックしてキャンセルします。

ユニット、サイト、部門またはフォルダの名前を変更するには：

1 RCSソフトウェアで、グループ選択ペインから削除するサーバー・タイプ、サイ

ト、部門またはフォルダを選択します。

2 Edit → Renameを順に選択します。Renameダイアログ・ボックスが表示され

ます。

3 フォルダ名を1～32文字の範囲で指定します。名前にはキーボードから入

力できる文字を任意に組み合わせて使用できます。また大文字と小文字

の区別はありません。スペースの使用は中間では構いませんが、最初と最

後には使用できません。同一の名前は、以下の2つの例外を除いては使
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用できません。同一の部門名は異なるサイト間であれば使用可能であり、

また同一フォルダ名は異なるレベルの間であれば使用可能です。

4 OKをクリックして新しい名前を保存します。

Explorerウィンドウのカスタマイズ

RCSソフトウェアのExplorerウィンドウのサイズはいつでも変更可能です。アプリ

ケーションを起動させるたびに、Explorerウィンドウはデフォルトのサイズと位置で

開きます。アプリケーション実行中に手動でウィンドウ・サイズを変更することはで

きますが、その情報は保存されません。つまり、Explorerを次回起動させる際に、

再びデフォルトのサイズと位置で開くことになります。

グループ選択ペインとユニット選択ペインは、画面を縦に走る分割ペイン・ディバ

イダーにより分割されています。ディバイダーを左右に移動すると、グループ選択

ペインとユニット選択ペインの表示領域を変更できます。Explorerを起動するた

びに、ディバイダーはデフォルト位置に戻ります。

スタートアップ時の指定表示の変更

スタートアップ時のオプションのSelectedビューの下でDefaultがチェックされている場

合、表示内容はExplorerにより決定されます。1つまたは複数のサーバーが定義

されている場合は、デフォルトでServersタブが表示されます。これ以外の場合

は、Remote Console Switchesタブが表示されます。

Defaultがチェックされていない場合、Explorerは、チェックボックスの下に示される

ドロップダウン・リストで選択された表示内容を表示します。ドロップダウン・リスト

には、Remote Console Switches、Servers、Sites、およびFoldersの値が含まれ

ます。ドロップダウン・リストは、チェックボックスが無効の場合にのみ有効です。

スタートアップ時の指定表示方法を変更するには：

1 RCSソフトウェアのExplorerメニューから、Tools → Optionsを順に選択しま

す。Optionsダイアログ・ボックスが表示されます。

2 ドロップダウン・リストから、Remote Console Switches、Servers、Sites、また

はFoldersのいずれかを選択します。

3 OKをクリックして新しいスタートアップ・ビューを保存します。
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-または-
Cancelをクリックして変更を保存せずに終了します。

デフォルト・ブラウザの変更

ブラウザ・ウィンドウでサーバーURLを表示する際にどのブラウザを起動するかを指

定することができます。使用システムのデフォルト・ブラウザを使用するよう選択す

るか、あるいはこのサーバーで起動させる特定のブラウザを選択します。

デフォルト・ブラウザを変更するには：

1 ExplorerメニューからTools → Optionsを順に選択します。Optionsダイアログ・

ボックスが表示されます。

2 Launch Default Browserチェックボックスをクリックして無効にします。Browse
ボタンが有効になります。

3 Browseボタンをクリックし、ブラウザへ移動します。

4 OKをクリックして新しいブラウザの選択を保存します。

-または-
Cancelをクリックして変更を保存せずに終了します。

ローカル・データベースの管理

このソフトウェアを実行している各クライアント・ワークステーションには、使用ユニッ

トに関して入力された情報を記録するローカル・データベースが含まれています。

複数のクライアント・ワークステーションがある場合には、一台のステーションを設

定した後に、そのデータベースのコピーを保存し、それを他のステーションに読み

込むと、各ステーションで再設定を行う手間を省くことができます。また、そのデー

タベースをエクスポートして、別のアプリケーションで使用することもできます。

データベースの保存

RCSソフトウェアでは、ローカル・データベースのコピーを保存できます。保存され

たデータベースは、後に、データベースが作成された同じコンピューターに戻して

読み込むか、または別のクライアント・ワークステーションに読み込むことができま

す。保存されたデータベースは、単一のZipファイルに圧縮収納できます。
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データベースの保存実行中は、これ以外のすべてのアクティビティは実行できず、

その他すべてのウィンドウを閉じる必要があります。他のウィンドウが開いている場

合にはメッセージが表示され、開いているウィンドウをすべて閉じてデータベースの

保存を続行するか、またはデータベースの保存処理をキャンセルするかの選択を

求められます。

データベースを保存するには：

1 RCS Explorerのメニューから、File → Database → Saveを順に選択しま

す。Database Saveダイアログ・ボックスが表示されます。

2 保存するデータベースを選択するには：

3 ファイル名を入力して、ファイルを保存する場所を参照します。

4 Saveをクリックします。保存中は進行状態を示すバーが表示されます。完

了するとメッセージが表示され、保存が正しく実行されてメイン・ウィンドウに

戻ることが示されます。

データベースの読み込み

この機能により、前に保存したデータベースを読み込むことができます。すべての

アクティビティを停止し、他のすべてのウィンドウを閉じる必要があります。他のウィ

ンドウが開いている場合にはメッセージが表示され、開いているウィンドウをすべ

て閉じてデータベースの読み込みを続行するか、またはデータベースの読み込み

処理をキャンセルするかの選択を求められます。

データベースを読み込むには：

1 メニューからFile → Database → Loadを順に選択します。Database Loadダ
イアログ・ボックスが表示されます。

2 読み込むデータベースを参照して選択します。

3 Loadをクリックします。読み込み中は進行状態を示すバーが表示されます。

完了すると、読み込みが正しく実行されたことを知らせるメッセージが表示さ

れ、メイン・ウィンドウに戻ります。



62xxx | 基本のソフトウェア操作xxx

データベースのエクスポート

この機能を使うと、各フィールドをローカル・データベースからASCCIIカンマ区切り

形式ファイル( CSV)またはタブ区切り形式ファイル( TSV)にエクスポートすること

ができます。エクスポートされるのは次のデータベース・フィールドです。

Remote Console Switchフラグ

タイプ

名前

住所

サイト

部門

場所

説明

連絡先名

連絡先電話番号

コメント

ブラウザURL

Telnetポート

注： Addressフィールドは、Remote Console Switchにのみ適用され、Browser URL
フィールドはサーバーのみに適用されます。エクスポートされたファイルで、サーバーの
場合は、Addressフィールド・データが空になり、Remote Console Switchの場合
は、Browser URLフィールド・データが空になります。

エクスポートされたファイルの第一行目には、フィールド・データのコラム名が表示

されます。次行以降の各行には、Remote Console Switchまたはサーバーの

フィールド・データが表示されます。このファイルには、ローカル・データベースで定

義される各Remote Console Switchおよびサーバーについての情報を有する行が

含まれています。

データベースをエクスポートするには：



基本のソフトウェア操作xxx | xxx63

1 メニューからFile → Database → Exportを順に選択します。Database
Exportダイアログ・ボックスが表示されます。

2 ファイル名を入力し、エクスポートされたファイルを保存する場所へ移動しま

す。

3 エクスポートする形式の種類を、Files of Typeドロップダウン・リストから選択

します。

4 Exportをクリックします。エクスポート中は進行状態を示すバーが表示されま

す。完了すると、エクスポートが正しく実行されたことを知らせるメッセージが

表示され、メイン・ウィンドウに戻ります。
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ビューアの使用法

Remote Console Switchシステム内のサーバーには、ビューアを使用して接続で

きます。このビューアから、サーバーのキーボード、モニター、マウス機能を完全にコ

ントロールできます。また、個々のサーバーのサムネール・ビューアで表示を有効

にすることで、カスタマイズしたサーバーの一覧を使用してスキャンすることもできま

す。これは一連のサムネール・フレームの表示で、各フレームはサーバー画像の

縮小／非インタラクティブ版になっています。詳細については、 「スキャン・モード

を使用した複数サーバーの表示」 (ページ 81) を参照してください。

RCSソフトウェアからのサーバーへのアクセス

RCSソフトウェアのServersタブには、データベース内で定義されているサーバーのリ

ストが表示されます。グループ選択 ペインが表示され、データベースで定義され

ているサーバーの固有な種類がすべてツリー表示で表示されます。グループ選

択ペインは、複数のサーバー・タイプが定義されている場合にのみ表示されま

す。All Servers、またはフォルダのどちらかをクリックして、特定タイプのすべての

サーバーを表示できます。サーバーを選択してConnect Videoタスク・ボタンをク

リックすると、ビューアが起動します。
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図 4.1：RCSソフトウェア - Serversタブ

サーバーにアクセスするには：

1 ExplorerでServersタブをクリックします。

2 ユニット選択ペインでサーバーを選択します。

3 Connect Videoタスク・ボタンをクリックします。

-または-
サーバーを右クリックします。ポップアップ・メニューが表示されま

す。Connect Videoを選択します。

-または-
サーバー名をダブルクリックします。

-または-
Enterキーを押します。新しいウィンドウで ビューアが起動されます。

システム内でサーバーを検索するには：

1 Serversタブをクリックして、検索テキスト・ボックス内にカーソルを置きます。
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2 検索情報を入力します。これは、サーバー名、あるいは別のユニット選択リ

ストのヘディングであるTypeやLocationとして入力した情報でも構いません。

3 検索ボタンをクリックします。結果はユニット・リストに表示されます。

4 検索の結果を参照します。

-または-
Clear Resultsボタンをクリックし、リスト全体をもう一度表示します。

閲覧中のサーバーとのインターラクション

サーバーへの接続がいったん確立されると、自分の画面にサーバーのデスクトッ

プ・ウィンドウが表示されるようになります。これは別のウィンドウとして表示されま

す。ローカルのカーソルとサーバーのカーソルの2つが表示されます。一緒に移動し

ない場合に位置合わせを行ったり、飛び跳ねるような場合にはビデオを調整す

る必要がでてくる場合があります。このウィンドウから、あたかもサーバーの前に着

座しているかのように、このサーバーの通常機能全般にアクセスすることができま

す。また、特定のマクロ・コマンドをサーバーに送信するなどの、ビューア固有のタ

スクも実行できます。

注： リモート・ビデオ・セッション中にマウスの反応が遅くなった場合は、対象デバイス
のオペレーティング・システムでマウスの加速をオフにし、マウスの速度を50%に設定し
てください。
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ビューア・ウィンドウの機能

図 4.2：ビューア・ウィンドウ

1 メニュー・バー：ビューアの機能の多くにアクセスできます。

2 アクセスしたサーバーのデスクトップ：このウィンドウからサーバーと対話します。
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ビューアのメニュー・バー

図 4.3：ビューアのメニュー・バー

1 画鋲：クリックするとメニュー・バーが所定の位置に固定されます。固定するこ

とにより、メニュー・バーからマウス・カーソルを移動した後もメニュー・バーが非

表示になりません。

2 メニュー・オプション：メニューからビューアで利用できる機能にアクセスします。

3 ツールバー・ボタン：ツール・バーには最大10個のボタンを追加できます。これ

らのボタンを使用すると、定義済みの機能およびキーボードのマクロに簡単

にアクセスできます。デフォルトでは、ローカル・カーソルの位置合わせ、画像

の更新、およびシングル・カーソル・モードの各ボタンが表示されます。

4 接続ステータス・インジケーター：接続ステータス・インジケーターに、ユーザー

がこのサーバーのアプライアンスにどのように接続されているかが表示されま

す。詳細については、「セッション共有オプション」 (ページ 89) を参照してくだ

さい。

接続ステータス・インジケーター： 共有モード

エクスクルーシブ・モード

アクティブな接続( 通常、非共有、非エクスクルーシ

ブ・セッション)

表 4.1：接続ステータス・インジケーター
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接続ステータス・インジケーター： 共有モード

能動共有( プライマリ・ユーザー)

能動共有( セカンダリ・ユーザー)

受動共有

ステルス・モード

スキャン

5 スマート・カードのステータス・インジケーター：スマート･カードの状態は、ビデ

オ・ビューアのツールバーの右端にあるスマート･カード･アイコンに表示されま

す。

アイコン 説明

スマート・カードがスマート・カード・リーダーに挿入されていないか、また

はスマート・カード・リーダーが接続されていません。

スマート・カードはスマート・カード・リーダーに入っていますが、マッピング

されていません。

スマート・カードはマッピングされています。

表 4.2：スマート・カードのステータス・インジケーター

ビューアの調整

各ユーザーの要件に合わせてビューア設定を調整できます。この調整には、画

面の解像度やツールバーの設定、キーボードのマクロ設定などが含まれます。
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ビューア・ツールバーの調整

ツール・バーには最大10個のボタンを追加できます。これらのボタンを使用する

と、定義済みの機能およびキーボードのマクロに簡単にアクセスできます。デフォ

ルトでは、Align Local Cursor、Refresh Image、およびSingle Cursor Modeの各

ボタンが表示されます。

ツールバーにボタンを追加するには：

1 ビューアのToolsメニューからSession Optionsを選択します。Session Options
ツールバーが表示されます。

2 Toolbarタブをクリックします。

3 ビューアのツールバーに追加する項目をクリックして選択します。

4 OKをクリックして変更内容を受け入れ、 ビューアのメイン・ウィンドウに戻りま

す。

図 4.4：Session Optionsダイアログ・ボックスのToolbarタブ

ツールバーの非表示遅延時間の設定

画鋲 ボタンがクリックされていなければ、マウス・カーソルを離した後、ツールバー

は非表示になります。マウス・カーソルを離してからツールバーが消えるまでの時
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間は、Toolbar Hide Delayの時間を調整することで変更できます。

Toolbar Hide Delayの時間を変更するには：

1 ビューアのToolsメニューからSession Optionsを選択します。Session Options
ツールバーが表示されます。

2 Toolbarタブをクリックします。

3 Toolbar Hide Delayフィールドに、マウス・カーソルを離した後にツールバーを

表示したい秒数を入力します。

-または-
UpとDownのボタンをクリックして、マウス・カーソルを離した後にツールバー

を表示する秒数を増減します。

4 OKをクリックして変更内容を受け入れ、ビューアのメイン・ウィンドウに戻りま

す。

ビューアの拡大と更新

デフォルトでは、ビューアの表示を調整するための3つのボタンがビューアのツール

バーに表示されています。最初のボタンは、ビューアをSingle Cursor Modeに設

定する場合に使用します。この設定により、サーバー上と同じようにビューアでマ

ウスを使用できます。ビューアがSingle Cursorモードに設定されている場合、ロー

カル・カーソルは表示されません。

注： シングル・カーソル・モードは、Windowsプラットフォーム上でのみ有効です。

2番目のボタンはビデオを更新するために、3番目のボタンはマウス・カーソルの位

置合わせに使用します。

図 4.5：ビューアのツールバー － 表示調整ボタン

ビューアをシングル・カーソル・モードに設定するには：

ビューアのツールバーで、Single Cursor Modeボタンをクリックします。

画面を更新するには：
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ビューアのツールバー上のRefresh Imageボタンをクリックします。

-または-

ビューアのメニューから、View→ Refreshを順に選択します。デジタル化されたビ

デオ・イメージは完全に再生成されます。

マウスのカーソルの位置を合わせるには：

ビューアのツーバー上のAlign Local Cursorボタンをクリックします。ローカル・カーソ

ルの位置がリモート・サーバー上のカーソルと揃います。

フルスクリーン・モードにするには：

ビューアの右上隅の最大化ボタンをクリックします。

-または-

ビューアのメニューからView→ Full Screenを選択します。デスクトップ・ウィンドウ

は表示されなくなり、アクセスされたサーバーのデスクトップだけが見えるようになり

ます。画面のサイズは、最高で1600 x 1200(標準 )と1680 x 1050(ワイドスクリー

ン)の解像度まで変更されます。モニターのデスクトップ解像度がこれより優れて

いる場合は、フルスクリーンのイメージが黒の背景で縁取られます。浮動ツール

バーが表示されます。

フルスクリーン・モードを終了するには：

Escキーを押してフルスクリーン・モードを終了し、デスクトップ・ウィンドウに戻りま

す。

ビューアの解像度の調整

Auto Scaleが有効に設定されている場合、セッション中にビューアのウィンドウの

サイズが変更されるのに従い、自動的に表示が調整されます。共有を使用し

てチャンネルにアクセスすると、そのチャンネルのプライマリー・ユーザーが選択した

入力解像度に合わせて表示が調整されます。これにより、プライマリー・ユーザー

が影響を受けずに済みます。解像度がセッション中に変更されると、表示が自

動的に調整されます。
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Full Scaleが選択されている場合、ビューアはサーバーの画面解像度に調整さ

れ、最大1600 x 1200(標準 )および1680 x 1050(ワイドスクリーン)まで画面サイ

ズを拡大します。

ビューアのウィンドウのサイズを調整するには：

メニュー・バーからView→ Scaling → Auto Scaleを選択して、サーバーの画像

のサイズを自動的に調整します。

-または-

メニュー・バーから、View→ Scaling → Full Scaleを選択します。

-または-

Scalingサブメニューから画面解像度を選択します。

図 4.6：ビューアのスケール

ビデオ画質の調整

ビューアは自動／手動のビデオ調整機能を備えています。一般に、Automatic
Video Adjustmentを選択した場合には、調整可能な範囲で最高のビデオ画像

に最適化されます。しかしながら、特定のニーズに合わせてビデオを変更すること

も可能です。大きく調整する場合は、スライダー・バーを使用します。Plus(+)
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とMinus( -)のボタンを使って微調整できます。手動でのビデオ調整の詳細につ

いては、図 4.7を参照してください。

色の深度の調整

注： Colorコマンドは、プライマリ・ユーザーのみが使用できます。このコマンドはセッ
ションを共有するプライマリ以外のユーザーは使用できません。

注： Session Optionsダイアログ・ボックスでBackground Refreshが有効になっている場
合は、色の解像度が自動的にBest Color Availableにセットされ、変更はできませ
ん。

Colorサブメニューを使用すると、デジタル画像を圧縮する際の色の解像度を設

定できます。Remote Console Switchは、Dambrackasビデオ圧縮 ( DVC)アルゴリ

ズムをサポートしています。このアルゴリズムにより、RCSソフトウェアのユーザー

は、リモート・セッション・ウィンドウで表示可能な色の数を調整できます。表示色

数を増やすと最高の忠実度が得られ、色数を減らすとネットワーク上で転送さ

れるデータ量が減少します。

ビューアのウィンドウはBest Color Available(更新間隔が長い) 、Best
Compression(更新間隔が最も短い) 、またはBest ColorとBest Compressionと
の組み合わせの使用、あるいはGrayscaleで表示できます。

個々のポートとチャンネルの色の解像度は、Remote SessionウィンドウでView
→ Colorの順にコマンドを選択して指定できます。この設定はポート別および

チャンネル別に保存されます。

色の解像度を設定するには：

ビューアのメニューからColorを選択し、Colorサブメニューから色の解像度を選択

します。

ビューア・ウィンドウのビデオ画質を手動で調整するには：

1 ビューア・メニューで、Tools → Manual Video Adjustを順に選択しま

す。Manual Video Adjustダイアログ・ボックスが表示されます。

2 調整する機能のアイコンをクリックします。

3 スライダー・バーを移動するか、またはMinus( -)またはPlus (+)ボタンをク

リックすることで、押されている各アイコンに対応するパラメーターを調整しま

す。調整は直ちにビューアのウィンドウに反映されます。
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4 完了したら、 Closeをクリックし、Manual Video Adjustダイアログ・ボックスを

終了します。

Manual Video Adjustダイアログ・ボックスのオプション

図 4.7：Manual Video Adjustダイアログ・ボックス

注： OBWIを使用してビューアを起動した場合は、上記のようなManual Video Adjust
ダイアログ・ボックスが表示されます。RCSソフトウェアを使用してビューアを起動した
場合は、Closeボタンの上にHelpボタンも表示されます。

1 画像キャプチャーの幅

2 ピクセル・サンプリング微調整

3 画像キャプチャーの水平位置

4 画像キャプチャーの垂直位置
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5 コントラスト

6 明るさ

7 ノイズのスレッシュホールド

8 スレッシュホールド優先順位

9 自動ビデオ調整

10 画像の更新

11 調整バー

12 ビデオ・テスト・パターン

13 Help

14 Performance Monitor

15 Closeボックス

リモート・ビデオ・セッションの変色抑制

リモート・ビデオ・セッションを設定する場合、ネットワーク状態が原因となるピクセ

ルの色落ちが発生することがあります。この状況は、背景が純色の場合に最も

多く起こります。これは黒い背景を使用することで最小限に抑えられます。カラー

の背景を使用した場合、画面上のピクセルの少数が色落ちするか白くなりま

す。

リモート・ビデオのピクセルの色落ちを最小限に抑えるには：

1 ビューア・メニューで、Tools → Manual Video Adjustを順に選択しま

す。Manual Video Adjustダイアログ・ボックスが表示されます。

2 コントラストまたは明るさを選択します。

3 画質が改善されるまで、コントラストと明るさを少しずつ調整します。

4 インクリメンタルな微調整には、Tools → Manual Video Adjustのノイズのス

レッシュホールド設定も使用できます。
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注： ノイズのスレッシュホールドをゼロまで下げると、ビデオが継続的に更新され、
ネットワーク利用率が上がり、ビデオのちらつきが起こります。Dellでは、ノイズのスレッ
シュホールドを最大に設定し、移動するマウス・カーソルの下のピクセルの色が復元
される間も、システムの性能が効率よく活用されるようにすることを推奨します。

注： ノイズのスレッシュホールドを調整する場合、大きく調整する場合はスライダー・
バーを、微調整する場合はスライダー・バーの両端のPlus( +) ボタンとMinus( -) ボタ
ンを使用します。

画面の背景色表示の改善

写真画像や多色使いのグラデーション背景が選択されているターゲット・サー

バーを表示している場合、色表示が途切れることがあります。最適な画質なら

びに性能が得られるよう、オペレーティング・システムの背景色には純色を選択す

るようお薦めしています。

マウスの調整

ビューアでは、マウス・カーソルの5つの異なるオプションを選択し、マウスのスケーリ

ングを設定し、正しくトラッキングしなくなったマウスを再同期することができま

す。Dellでは、Local CursorオプションをNoneに設定して、ローカル・カーソルをオフ

にすることを推奨します。こうすると、画面上にはリモート・カーソル一つだけが残

ることになり、操作が容易になります。

図 4.8：ビューアのマウスのSession Optionsダイアログ・ボックス



ビューアの使用法xxx | xxx79

マウス・スケーリングの設定

マウス・スケーリングの設定は、事前に設定されたマウス・スケーリング設定のオプ

ション3種から選択するか、またはユーザー自身のカスタム・スケーリングを設定す

ることもできます。事前に設定されている3つのオプションには、Default
(1:1)、High (2:1)、または Low (1:2) があります。 1:1のスケーリング率では、デスク

トップ・ウィンドウでのマウスのすべての動きは、実際の動きと同等の動きとして

サーバーに送られます。2:1 のスケーリングでは、マウスの動きは2倍速の動きとし

て送られます。1:2のスケーリングでは、2分の1の速度になります。

マウス・スケーリングをカスタム設定するには：

1 ビューアのメニューでTools → Session Optionsを順に選択します。Session
Optionsダイアログ・ボックスが表示されます。

2 Mouseタブをクリックします。

3 Customオプション・ボタンをクリックします。Xフィールド、Y フィールドが有効に

なります。

4 必要なマウスのスケーリング値を、XフィールドとYフィールドに入力します。マ

ウスの各入力に対し、マウスの動きは、XとYの各スケール係数を乗じた動き

となります。有効な入力範囲は、0.25～3.00です。

マウスの軌跡の最小化

リモート・ビデオ・セッションの間、画面上をマウスが移動したとき、一部のピクセル

が色落ちした状態で残ります。この状態はマウスの軌跡と呼ばれ、ネットワーク・

レベルの変動、および異なる環境でのその他のノイズが原因で生じます。マウス

の軌跡を最小限に抑えるには、Manual Video Adjustダイアログ・ボックス

のNoise Thresholdの値を低くする必要があります。

ノイズのスレッシュホールドを下げるには：

1 ビューア・メニューで、Tools → Manual Video Adjustを順に選択しま

す。Manual Video Adjustダイアログ・ボックスが表示されます。

2 調整する機能のNoise Adjust Thresholdアイコンをクリックします。
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3 マウスを使用して、スライダー・バーをスケールの中央に移動し、ゼロに下げ

ます。

4 スライダー・バーの両端のPlus( +)ボタンとMinus(  -)ボタンを使用して、ノイ

ズのスレッシュホールドをゼロの真上に微調整します。

注： ノイズのスレッシュホールドをゼロに設定すると、ビデオが継続的に更新されるた
め、ネットワーク利用率が上がり、ビデオのちらつきが起こります。ノイズのスレッシュ
ホールドは最大に設定し、移動するマウス・カーソルの下のピクセルの色が復元され
る間も、システム性能を効率化することをお薦めしています。

注： ノイズのスレッシュホールドを調整する場合、大きく調整する場合はスライダー・
バーを、微調整する場合はスライダー・バーの両端のPlus( +) ボタンとMinus( -) ボタ
ンを使用します。

マウスの性能の改善

マウスの応答が遅かったり、リモート・ビデオ・セッションでマウス・ポインタが同期を

外れる場合は、ターゲット・サーバーのオペレーティング・システムでマウスの加速を

無効化して対処できます。

Microsoft Windows：

1 マウスの加速をオフにします。

2 マウスの速度を、スライダー・バーの真ん中に調整します。

注： 具体的な手順については、Windowsオペレーティング・システム付属のマニュア
ルを参照してください。

Red Hat Linux：

1 Desktop ControlsからMouse設定を選択します。

2 Accelerationを1.0に設定します。

3 マウスを再同期する場合は、ビューアのAlign Local Cursor/Mouseボタンを

使用します。

マウス・カーソルのちらつきの抑制

RCSソフトウェア・クライアント・マシンのビデオ・ドライバーがDirectDraw® をサポー

トしない場合に、RCSソフトウェアのDirectDrawオプションが有効になっていると、
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画面上でマウス・カーソルのちらつきが起こります。RCSソフトウェアの出荷時デ

フォルトでは、DirectDrawは無効になっています。クライアント・システムのビデオ・

ドライバーがDirectDrawをサポートしており、性能を向上させたい場合、次の手

順に従ってDirectDrawを有効にします。

DirectDrawを有効または無効にするには：

1 Explorerウィンドウで、Tools → Optionsを選択します。

2 DirectDrawチェック・ボックスをクリックして有効または無効にします。

3 OKをクリックします。

4 RCSソフトウェアを再起動します。

スキャン・モードを使用した複数サーバーの表示

ビューアでは、スキャン・モードのサムネール・ビューアにより複数のサーバーを同時

に表示することができます。これは一連のサムネール・フレームの表示で、各フ

レームはサーバー画像の縮小／非インタラクティブ版になっています。各サムネー

ルの下には、ステータス・インジケーターとともにサーバー名が表示されます。

サーバーのスキャン

サムネールビューアにより、最高16台のサーバーのスキャン・シーケンスをセットアッ

プして、使用中のサーバーをモニターできます。スキャン・モードでは、サムネール

画像が一つずつ移動します。このとき、サーバーにログインした後、(View Time
Per Serverで)ユーザーが指定した時間だけ最新のサーバー画像が表示され、

その後そのサーバーからログアウトして、次のサムネール画像に移動します。ま

た、サムネール間のスキャン遅延を指定することもできます(Time Between
Serversを使用 )。この遅延の間は、他のサーバーにログインはしないものの、ス

キャン・シーケンスに含まれるすべてのサーバーの最後のサムネール画像が表示

されます。

各フレーム表示の下の表示ライトに、サーバーのステータスが表示されます。サム

ネールのデフォルト・サイズはスキャンリスト内のサーバー数によって異なります。
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図 4.9：ビューアでのサムネール・ビューア

スキャン・モードは、アクティブな接続よりも優先順位が低くなります。サーバーとイ

ンタラクティブ・セッションを行っている場合、そのサーバーはスキャン・シーケンス内

で飛ばされ、スキャン・モードは次のサーバーへ進むことになります。ログインのエ

ラー・メッセージは表示されません。インタラクティブ・セッションが終了すると、サム

ネールが再びスキャン・シーケンスに含まれます。別のユーザーがサーバーとのアク

ティブな接続を確立している場合、そのサーバーはスキップされ、フレームの下の

表示灯に赤い「X」文字が表示されます。

RCSソフトウェアは、複数のRemote Console Switchに接続されているサーバーを

スキャンできます。
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RCSソフトウェアからのスキャン・モードへのアクセス

図 4.10：RCSソフトウェア - サーバーのスキャン

RCSソフトウェアでスキャン・モードにアクセスするには

1 Explorerで、Remote Console Switch、Servers、Sites、Foldersのいずれかの

タブを選択します。

2 Shiftキーを押しながら、ユニット選択ペインで2台以上のサーバーを選択しま

す。

-または-
Ctrlキーを押します。Scan Modeタスク・ボタンが現れます。

3 Scan Modeタスク・ボタンをクリックします。サムネール・ビューアウィンドウが現

れます。
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サムネール・ビューのステータス表示

緑色のLEDはサーバーが現在スキャンされていることを示します。赤色のXはそ

のサーバーのスキャンが前回正しく行われなかったことを示します。スキャンは、ア

カウント情報や無効なパス( Remote Console Switch上のサーバー・パスが使用

不可 )、あるいは他の何らかの理由により正しく実行されない場合があります。

マウス・ポインタを赤いX上に合わせると、ツールのヒントが表示され、失敗の理

由が示されます。

スキャン設定を設定するには：

1 サムネール・ビューから、Options → Preferencesを順に選択しま

す。Preferencesダイアログ・ボックスが表示されます。

2 View Time Per Serverボックスに、スキャン中に各サムネールがアクティブにな

る時間 ( 10～60秒 )を入力します。

3 Time Between Serversボックスに、各サーバーの間でスキャンが停止する時

間の長さ( 5～60秒 )を入力します。

4 OKをクリックします。

サムネール・ビューアの操作

個々のサムネール・フレームをハイライトしてサムネール・メニューを選択すると、そ

のサーバーのインタラクティブ・セッションを立ち上げたり、そのサーバーをスキャン

シーケンスに追加したり、そのサーバーのログインのアカウント情報を設定したりす

ることができます。Optionsメニューでは、スキャン設定へのアクセスに加え、スキャ

ンの一時停止、全サーバーのサムネール・サイズ設定などができます。

サーバーのビデオ・セッションを起動にするには：

1 サーバーのサムネールを選択します。

2 サムネール・ビューアからThumbnail → [サーバー名 ] → View Interactive
Sessionを順に選択します。

-または-
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サーバーのサムネールを右クリックして、View Interactive Sessionを選択

します。インタラクティブなビューア・ウィンドウで、サーバーのビデオが起動

します。

スキャン・シーケンスでサーバーを有効または無効にするには：

1 サーバーのサムネールを選択します。

2 サムネール・ビューアから、Thumbnail → [サーバー名 ] → Enableを選択しま

す。

-または-
サーバーのサムネールを右クリックし、Enableを選択します。そのサーバー

は、サーバーのサムネールのスキャン・シーケンスに含まれるか、除外され

ます。

注： Enableメニュー項目の状態は、選択するたびにチェック付き( 有効) からチェック
なし( 無効) に切り替わります。

注： サーバーがユーザーからアクセスされている場合、そのサーバーのサムネールに
ついてはEnableメニューは無効になります。

スキャン・シーケンスを一時停止または再始動するには：

サムネール・ビューアから、Options → Pause Scanを順に選択します。サムネー

ル・ビューアでスキャンが進行中の場合、スキャン・シーケンスは現在のサムネー

ルで一時停止し、スキャンが一時停止している場合はスキャン・シーケンスが再

開します。

サムネールのサイズを変更するには：

1 サムネール・ビューアから、Options → Thumbnail Sizeを順に選択します。

2 必要なサムネールのサイズをメニューから選択します。

マクロを使用したキーストロークのサーバーへの送信

ビューアのMacrosメニューを使うと、複数のキーストロークを簡単にサーバーに送

ることができます。ビューアには、Microsoft Windowsシステム、Sunシステ

ム、Linuxシステムで利用できるキーストローク選択項目のリストが表示されま

す。

どちらのシステムを使うかを選ぶには：
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ビューアでMacroメニューをクリックします。Display on Menuを選択

し、Windows、Sun、Linuxのいずれかを選択します。

キーストロークをサーバーに送るには：

ビューアのMacroメニューをクリックし、サーバーに送信するキーストロークを含

むMacroの名前を選択します。図 4.13、図 4.11および図 4.11に利用できるマク

ロを示します。

図 4.11：ビューアのマクロ・メニュー展開表示 ( Windowsオプション)
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図 4.12：ビューアのマクロ・メニュー展開表示 ( Sunオプション)

図 4.13：ビューアのマクロ・メニュー展開表示 ( Linuxオプション)

Session Options - Generalタブ

Session Optionsダイアログ・ボックスのGeneralタブを使用すると、フルスクリーン以

外のモードでのKeyboard Pass-throughオプション、Menu Activation Keystroke、
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およびBackground Refreshの選択内容を制御できます。

Keyboard Pass-throughチェック・ボックスでは、Keyboard Pass-throughモードを有

効にするかどうかを指定できます。Keyboard Pass-throughオプションは、デフォル

トでは選択されていません。

図 4.14：Session Options - Generalタブ

Menu Activation Keystrokeリスト( None、Pause、F1～F12)を使用すると、ツー

ルバーを起動するキーストロークを選択できます。

Background Refreshチェック・ボックスでは、背景の更新を有効にするかどうかを

指定できます。このオプションを選択した場合、デバイスで変更が生じたかにかか

わりなく、ビューアにデバイスから一定のデータの流れが送信されます。

セッション・オプションを変更するには：

1 ビューアのToolsメニューからSession Optionsを選択します。Session Options
ツールバーが表示されます。

2 Generalタブをクリックします。

3 セッションのオプションを必要に応じて変更します。

4 OKをクリックします。
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スクリーン・キャプチャー

ビューアでは、画面の内容をキャプチャーし、ファイルに保存したり、クリップボード

にコピーしたりできます。

ファイルに画面をキャプチャーするには：

1 ビューアでFile → Capture to Fileを選択します。Saveダイアログが表示され

ます。

2 ファイルを保存する場所を参照します。

3 File Nameフィールドにファイル名を入力し、Saveをクリックします。

クリップボードに画面をコピーするには：

ビューアでFile → Capture to Clipboardを選択します。画像がクリップボードに保

存され、文書や画像編集アプリケーションに貼り付けることができます。

注： Capture to Clipboard機能はLinuxでは利用できません。

セッション共有オプション

注： Dell 1081ADと2161ADスイッチの場合、セッション共有をサポートするためにDellリ
モート・アクセス・キー( RAK) が必要です。

セッション共有の構成を実行できるのは、管理者、およびアプライアンス管理者

またはユーザー管理者の管理者アクセス権を持つその他のユーザーです。ター

ゲット・デバイスとの最初のKVMセッションを開始したユーザーは、プライマリ・ユー

ザーと呼ばれます。別の(セカンダリ)ユーザーがこの同じターゲット・デバイスと

のKVMセッションを開始しようとした場合、セカンダリ・ユーザーに与えられるオプ

ションは次の2つの条件により異なります。

• 2人のユーザーのアクセス権

• 管理者がグローバル接続共有を構成しているかどうか

自動共有、エクスクルーシブ接続、およびステルス接続の構成はすべて、接続

の共有が有効になっている場合にのみ可能なオプションです。



90xxx | ビューアの使用法xxx

自動共有

接続の共有により、複数のユーザーが同時に共通のターゲット・デバイスと対話

することができます。プライマリ・ユーザーの場合、別のユーザーが接続の共有を

希望していることがダイアログ・ボックスによって知らされます。Yesを選択して共有

を許可するか、No を選択して共有を拒否できます。またはPassive Shareボック

スをクリックして、新しいユーザーにその接続への制御権を持たない共有を許可

することができます。

別のユーザーが表示しているデバイスでビデオ・セッションを開こうとした場合、そ

のデバイスが表示中であることが通知されます。共有設定の内容に応じて、ビ

デオ・セッションの共有またはプリエンプト操作のオプションが提供されます。また、

ステルス・ビデオ・セッションの開始オプションも提供されます。

デバイスへのアクセスは、デバイスに対する現在のユーザーの接続権限に左右さ

れます。ビデオ・セッション・ユーザーには、プライマリ・ユーザーおよび最大11の同

時接続セカンダリ・ユーザーの2種類があります。接続を共有するすべてのユー

ザーで、プリエンプト操作リクエストを許可または拒否できるのは、プライマリー・

ユーザーのみです。プライマリー・ユーザーはまた、ビデオ・パラメーターと、ビデオ・

セッションの表示解像度に対する制御権も維持します。

セカンダリ・ユーザーは、マウスおよびキーボードによるデータ入力が可能なアク

ティブなユーザーか、マウスおよびキーボードによるデータ入力が許可されていな

い受動ユーザーのいずれかになります。

Remote Console SwitchでAutomatic Sharingが有効になっている場合、セカンダ

リー・ユーザーはプライマリー・ユーザーにセッション参加の許可を求める必要はあ

りません。

プライマリ・ユーザーがそのセッションを終了すると、アクティブなユーザー権限を持

ち、参加順が最も古いセカンダリ・ユーザーがプライマリ・ユーザーになります。プラ

イマリ・ユーザーがセッションを終了するときに、アクティブなユーザーの権限を持ち

セッションを共有するセカンダリ・ユーザーが存在しない場合には、そのセッション

は終了します。

デジタル共有モードを使用すると、複数のユーザーがターゲット・デバイスの表示

とインターラクションを実行できます。セッション共有中、セカンダリ・ユーザーは、
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キーボードとマウスの制御権を持つアクティブ・ユーザー、または制御権のないパッ

シブ・ユーザーのどちらにもなり得ます。

KVMセッションを共有できるようにスイッチを構成するには、以下の手順で行いま

す：

1 ExplorerでAppliancesボタンをクリックします。

2 次の手順のいずれかを実行します：

• ユニット・リスト内のRemote Console Switchをダブルクリックします。

• ユニット・リストからRemote Console Switchを選択し、Manage Appliance
ボタンをクリックします。

• ユニット・リスト内のRemote Console Switchを右クリックします。ポップアッ

プ・メニューから、Manage Applianceを選択します。

• ユニット・リストからRemote Console Switchを選択し、Enterキーを押しま

す。

3 Global - Sessionsのサブカテゴリーを選択します。

4 Connection Sharing領域内のEnable Share Modeを選択します。

5 Automatic Sharingを選択することもできます。自動共有を選択すると、セカ

ンダリ・ユーザーはプライマリ・ユーザーにアクセス権をリクエストせずに、自動

的にKVMセッションを共有できるようになります。

デジタル接続の共有は以下の手順で行います：

1 ExplorerでDevicesボタンをクリックします。

2 次の手順のいずれかを実行します：

• ユニット・リスト内のターゲット・デバイスをダブルクリックします。

• ターゲット・デバイスを選択し、Connect Videoボタンをクリックします。

• ターゲット・デバイスを右クリックします。ポップアップ・メニューからConnect
Videoを選択します。

• ターゲット・デバイスを選択し、Enterキーを押します。
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他のユーザーがこのターゲット・デバイスを参照している場合は、このター

ゲット・デバイスがすでにKVMセッション中であることを告げるメッセージが

表示されます。

スイッチで接続共有がオンになっており、(プライマリ・ユーザーのアクセス

権に対して優位な)アクセス権を持っている場合は、既存のセッションを

共有またはプリエンプトするように促すメッセージが表示されます。

1 選べる場合は、Shareを選択します。

2 次の手順のいずれかを実行します：

• OKまたはYesをクリックします。「自動共有」が有効になっていない場合

は、プライマリ・ユーザーに共有リクエストが送信されます。プライマリ・

ユーザーは、アクティブ・ユーザーまたはパッシブ・ユーザー(読み取り専

用 )として共有リクエストを承認することも、リクエストを完全に拒否する

こともできます。

• Noをクリックすると、共有リクエストはキャンセルされます。

プライマリ・ユーザーが共有リクエストを承認した場合、あるいはAutomatic
Sharingがオンになっている場合は、ターゲット・デバイス・セッションに対するKVM
セッションが開き、セッション・ステータスがアクティブかパッシブかを示すセッション・タ

イプ・アイコンが新たなビデオ・ビューア・ウィンドウ内に表示されます。リクエストが

拒否されると、その旨を告げるメッセージが表示されます。管理者には、この段

階でいくつかのオプションがあります。管理者はもう一度接続してセッションのプリ

エンプトを試行するか、ステルス・モードで接続するか、またはセッションを完全に

終了することができます。

共有モードで接続するためのプロンプトが表示されない場合、ターゲット・デバイ

スの接続先のスイッチでデジタル共有モード・セッションを許可するよう設定されて

いないか、またはスイッチがRemote Console Switchではないかのどちらかです。

エクスクルーシブ・モード

セッションの共有とエクスクルーシブ接続が有効になっていれば、エクスクルーシブ

のKVMセッションを確立できます。エクスクルーシブ・モード・セッションの場合、他

のユーザーからの共有リクエストは受信できません。ただし、管理者はセッションを
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プリエンプト(または終了 )するか、またはセッションをステルス・モードでモニターする

かを選択することができます。

Exclusive Modeを選択したときに他のユーザーがセッションを共有している場

合、Exclusive Mode の選択により他のユーザーはセッションから接続解除される

と警告を受けます。

注： エクスクルーシブ・セッションをリクエストできるのは、プライマリ・ユーザーのみで
す。エクスクルーシブ・モードのリクエスト時に他のユーザーが共有している場合、プラ
イマリ・ユーザーのアクセス・レベルかどうかにかかわらず、すべてのユーザーが接続解
除されます。

スイッチでエクスクルーシブのKVMセッションを有効にするには、以下の手順で行

います：

1 ExplorerでAppliancesボタンをクリックします。

2 次の手順のいずれかを実行します：

• ユニット・リスト内のRemote Console Switchをダブルクリックします。

• ユニット・リストからRemote Console Switchを選択し、Manage
Applianceボタンをクリックします。

• ユニット・リスト内のRemote Console Switchを右クリックします。ポップアッ

プ・メニューから、Manage Applianceを選択します。

• ユニット・リストからRemote Console Switchを選択し、Enterキーを押しま

す。

1 Global - Sessionsのサブカテゴリーを選択します。

2 Connection Sharing領域内のEnable Sharedチェック・ボックスを選択します。

3 Connection Sharing領域内のExclusive Connectionsを選択します。

エクスクルーシブ・モードでのビデオ・ビューアにアクセスできるのは、共有接続のプ

ライマリ・ユーザー、もしくは非共有セッションでの唯一のユーザーのみです。

エクスクルーシブ・モード中のビデオ・ビューアへのアクセスは以下の手順で行いま

す：

1 ターゲット・デバイスに対するKVMセッションを開始します。

2 Video Viewerツールバーから、Tools → Exclusive Modeを順に選択します。
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3 KVMセッションが現在共有中である場合、このセッションをエクスクルーシブに

指定できるのはプライマリ・ユーザーのみです。プライマリ・ユーザーは、エク

スクルーシブ・セッションのコマンドが実行されるとセカンダリ・ユーザーのセッショ

ンは終了される旨のメッセージを受けます。

次の手順のいずれかを実行します：

• Yesを選択すると、セカンダリ・ユーザーのセッションは終了されます。

• Noをクリックすると、エクスクルーシブ・モードの操作はキャンセルされま

す。

セカンダリ・ユーザーはエクスクルーシブのKVMセッションを共有できません。ただ

し、管理者または特定のアクセス権のあるユーザーの場合には、セッションを終

了させることができます。

ステルス接続

管理者は、ターゲット・デバイスにステルス・モードで接続し、リモート・ユーザーの

ビデオ出力を(ユーザーには分からない状態で)閲覧することができます。ステル

ス・モード中、管理者はターゲット・デバイスのキーボードやマウスを制御すること

はできません。

スイッチでステルスのKVMセッションを有効にするには、以下の手順で行います：

1 ExplorerでAppliancesボタンをクリックします。

2 次の手順のいずれかを実行します：

• ユニット・リスト内のRemote Console Switchをダブルクリックします。

• ユニット・リストからRemote Console Switchを選択し、Manage
Applianceボタンをクリックします。

• ユニット・リスト内のRemote Console Switchを右クリックします。ポップアッ

プ・メニューから、Manage Applianceを選択します。

• ユニット・リストからRemote Console Switchを選択し、Enterキーを押しま

す。

3 Global - Sessionsのサブカテゴリーを選択します。

4 Connection Sharing領域内のStealth Connectionsを選択します。
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ターゲット・デバイスをステルス・モードでモニターするには、以下の手順で行いま

す：

1 ExplorerでDevicesボタンをクリックします。

2 次の手順のいずれかを実行します：

• ユニット・リスト内のターゲット・デバイスをダブルクリックします。

• ターゲット・デバイスを選択し、Connect Videoボタンをクリックします。

• ターゲット・デバイスを右クリックします。ポップアップ・メニューからConnect
Videoを選択します。

• ターゲット・デバイスを選択し、Enterキーを押します。

3 他のユーザーがすでにこのターゲット・デバイスを参照している場合は、この

ターゲット・デバイスがすでにKVMセッション中であることを告げるメッセージが

表示されます。

スイッチで接続の共有およびステルス接続がオンになっており、アクセス

権 (プライマリ・ユーザーのアクセス権に対して優位な)を持っている場合

は、現行セッションを共有またはプリエンプトするように促すメッセージが

表示されます。選べる場合は、Stealthを選択します。

4 次の手順のいずれかを実行します：

• OKまたはYesをクリックします。

• Noをクリックするとステルス接続のリクエストはキャンセルされます。

ターゲット・デバイスへのKVMセッションが開き、管理者は他に分からな

い状態で、ターゲット・デバイスのビデオ出力をすべて参照できるようにな

ります。

ステルス接続がオプション中に表示されない場合には、下記のいずれかを意味

します：

• ターゲット・デバイスの接続先のスイッチでStealth Connectionsがオンになって

いない

• 必要なアクセス権がない(プリエンプト権限の次にステルス権限が位置して

います)
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• ターゲット・デバイスの接続先のスイッチがRemote Console Switchではない

プリエンプト・モード

プリエンプトは、有効な権限を持つユーザーが、同等またはそれ以下の権限を

持つ別のユーザーに対してサーバーを管理する方法です。

注： プリエンプト操作中の接続を共有するすべてのユーザーが警告を受けますが、
( 有効になっている場合) プリエンプト操作を拒否できるのはプライマリ・ユーザーのみ
です。

表 4.3に、プリエンプト操作のシナリオおよびプリエンプト操作リクエストを拒否する

シナリオの詳細を示しています。プリエンプト操作とバーチャル・メディア・セッション

の予約およびロックの詳細については、「セッション共有オプション」 (ページ 89) を

参照してください。

現在のユーザー プリエンプト操作リクエスト元
プリエンプト操作リクエス

ト拒否、可／不可

リモート・ユーザー ローカル・ユーザー 不可

リモート・ユーザー リモート管理者 不可

リモート・ユーザー Remote Console Switch管理者 不可

Remote Console Switch
管理者

ローカル・ユーザー 可

Remote Console Switch
管理者

Remote Console Switch管理者 可

リモート管理者 ローカル・ユーザー 不可

リモート管理者 リモート管理者 可

リモート管理者 Remote Console Switch管理者 不可

表 4.3：プリエンプト操作のシナリオ
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現在のユーザー プリエンプト操作リクエスト元
プリエンプト操作リクエス

ト拒否、可／不可

ローカル・ユーザー リモート管理者 可

ローカル・ユーザー Remote Console Switch管理者 可

リモート管理者によるリモート・ユーザーのプリエンプト操作

リモート管理者が、リモート・ユーザーによってアクセスされているサーバーへアクセ

スを試みた場合、プリエンプトされることがユーザーに通知されるまでの間待機す

るように管理者に求めるメッセージが表示されます。リモート・ユーザーはこのプリ

エンプト・リクエストを拒否できないため、接続解除されます。接続解除までの時

間は、Sessionダイアログ・ボックスのビデオ・セッションのプリエンプト操作タイムアウ

ト設定で定義します。

注： 表示中のサーバーがアボセント製スイッチに接続されている場合は、その期間
は表示されません。

ローカル・ユーザー／リモート管理者のリモート管理者によるプリエンプト操作

管理者が、同等の権限を持つローカル・ユーザーまたは別のリモート管理者に

よってアクセスされているサーバーへアクセスを試みた場合、現在接続している

ユーザーはプリエンプト操作リクエストを許可または拒否することができます。接

続しているローカル・ユーザーまたはリモート管理者に、プリエンプト操作リクエスト

を受け入れるかどうかを尋ねるメッセージが表示されます。プリエンプト操作リクエ

ストが拒否された場合、リモート管理者にリクエストの拒否およびサーバーへの

アクセス不可を伝えるメッセージが表示されます。

注： 表示中のサーバーがアボセント製スイッチに接続されている場合、ユーザーはプ
リエンプト操作の許可または拒否を選択することができません。

注： プリエンプト操作リクエストが拒否されるシナリオでは、Session Preemption
Requestダイアログ・ボックスが表示されます。このダイアログで、Acceptボタンをク
リックしてプリエンプト操作リクエストを許可したり、Rejectボタンをクリックするまたはダ
イアログ・ボックスを終了して、プリエンプト操作リクエストを拒否することができます。

現行のユーザーをプリエンプトする場合は以下の手順で行います：

1 ExplorerでDevicesボタンをクリックします。
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2 次の手順のいずれかを実行します：

• ユニット・リスト内のターゲット・デバイスをダブルクリックします。

• ターゲット・デバイスを選択し、Connect Videoボタンをクリックします。

• ターゲット・デバイスを右クリックします。ポップアップ・メニューからConnect
Videoを選択します。

• ターゲット・デバイスを選択し、Enterキーを押します。

他のユーザーがこのターゲット・デバイスを参照している場合は、このター

ゲット・デバイスがすでにKVMセッション中であることを告げるメッセージが

表示されます。

このスイッチで接続共有がオンになっている場合は、セッションを共有す

るかどうかを選択できます。接続共有の詳細については、「プリエンプト・

モード」を参照してください。アクセス権 (プライマリ・ユーザーのアクセス権

に対して優位な)を持っている場合は、現行セッションを共有またはプリ

エンプトするように促すメッセージが表示されます。

3 選べる場合は、Preemptを選択します。

4 次の手順のいずれかを実行します：

• OKまたはYesをクリックします。プライマリ・ユーザーにプリエンプト通知が

送られます。アクセス権がプライマリ・ユーザーより下位の場合、プライマ

リ・ユーザーはプリエンプト操作を拒否できることがあります。

• Noをクリックすると、プライマリ・ユーザーの接続は維持されます。

5 プリエンプト操作が完了すると、ターゲット・デバイス・セッションのビデオ・ビュー

アが開きます。

バーチャル・メディア

バーチャル・メディア・サポートにより、USBメディア・デバイスをアプライアンスのUSB
ポートに直接接続することができ、アプライアンスに接続されているどのターゲッ

ト・デバイスでも使用できます。バーチャル・メディアには、リモートからもアクセスで
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きます。リモート・メディア・セッションでは、クライアント・コンピューターに直接取り

付けたデバイスを使用します。

バーチャル・メディア機能により、あらゆるサーバーとの間でバーチャル・メディアの

データを表示、移動、コピーすることができます。オペレーティング・システムのイン

ストール、オペレーティング・システムの回復、ハード・ドライブの回復や複

製、BIOSの更新、サーバーのバックアップが可能になり、リモート・システムを効率

よく管理できます。

KVMセッションを行うユーザーは、ターゲット・デバイスにマップされたどのメディア・

デバイスにもアクセスできます。不正アクセスなどのセキュリティ・リスクを回避する

ため、バーチャル・メディア・セッションをKVMセッションにロックすることができます。

バーチャル・メディア・デバイスのメディアを変更する場合は、まず、バーチャル・メ

ディア・デバイスのマッピングを解除してください。それから新しいメディアを挿入し、

バーチャル・メディア・デバイスを再マッピングします。これで、このメディアを新しい

バーチャル・メディア・セッションで利用することができます。

バーチャル・メディア・サポートの要件を次に示します。

• DVD-ROMドライブ( 1台 )と大容量記憶装置 ( 1台 )は同時にマッピングでき

ます。

• CD/DVD-ROMドライブまたはISOディスク・イメージ・ファイルはバー

チャルのDVDドライブとしてマッピングされます。

• ディスク・ドライブ、ディスク・イメージ・ファイル、USBメモリー・デバイ

ス、その他のメディア・タイプはバーチャルの大容量記憶装置として

マッピングされます。

• 所定のサーバーでバーチャル・メディアを使用するには、Dell USB2 SIP、Dell
USB2+CAC SIP、Avocent MPUIQ-VMC、DSAVIQ-PS2M、また

はDSAVIQ-USB2のモジュールを用いて、そのサーバーをKVMに接続する必

要があります。

• パッシブ拡張モジュールに接続されているサーバーに対してバーチャル・メディ

ア・セッションを開始することはできません。

• バーチャルにマッピングしようとしているUSB2対応メディアのタイプが、ターゲッ

ト・デバイスでサポートされている必要があります。すなわち、ターゲット・デバ



100xxx | ビューアの使用法xxx

イスでポータブルUSB 2.0メモリー・デバイスがサポートされていない場合に

は、ローカル・デバイスをバーチャル・メディア・ドライブとしてターゲット・デバイス

にマッピングすることはできません。

• ユーザー(またはユーザーが所属するユーザー・グループ)には、バーチャル・メ

ディア・セッションまたはターゲット・デバイスに対する専用バーチャル・メディア・

セッションを確立する権限が必要です。

• 1082DSは、同時に3つまでのバーチャル・メディア・セッション(ローカル、リモー

トを含む)をサポートしています。2162DSは、同時に4つまでのバーチャル・メ

ディア・セッション(ローカル、リモートを含む)をサポートしています。4322DS
は、同時に6つまでのバーチャル・メディア・セッション(ローカル、リモートを含

む)をサポートしています。ターゲット・デバイスに対するバーチャル・メディア・

セッションは、一度に1つのセッションのみ実行可能です。

共有およびプリエンプト操作

KVMセッションとバーチャル・メディア・セッションは別個のものです。従って、共

有／専用／プリエンプト・セッションには多くのオプションがあります。

例えば、KVMセッションとバーチャル・メディア・セッションは、一緒にロックすることが

可能です。このモードでは、KVMセッションの接続が解除されると、関連付けら

れているバーチャル・メディア・セッションの接続も解除されます。これらのセッション

が一緒にロックされていない場合は、KVMセッションは終了しますが、バーチャ

ル・メディア・セッションはアクティブのままになります。

関連するアクティブなKVMセッションがないにもかかわらず、バーチャル・メディア・

セッションがターゲット・デバイスでアクティブになっている場合には、このチャンネル

へのオリジナル・ユーザー(ユーザーA)による再接続、または、別のユーザー(ユー

ザーB)による接続が可能です。ユーザーAのみがKVMセッションに関連付けられ

たターゲット・デバイスにアクセスできるよう設定することもできます。このオプション

( Reserved)はバーチャル・メディア・ウィンドウ内にあります。

ユーザーBがこのKVMセッションにアクセスしている場合 ( Reservedのオプションがオ

ンになっていない)、このユーザーはバーチャル・メディア・セッションで使用されてい

るメディアを制御することが可能です。これは、一部の環境においては望ましくな

い場合があります。
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ティアド接続環境でReservedオプションを使用すると、ユーザーAのみが下層アプ

ライアンスにアクセス可能で、上層アプライアンスと下層アプライアンス間のKVM
チャンネルがユーザーA専用となります。

プリエンプト・レベルにより、この他にも設定に柔軟性を持たせることができます。

「プリエンプト・モード」 (ページ 96) を参照してください。

バーチャル・メディアの起動

ビューアを使用して、バーチャル・メディアをアプライアンスからリモートで起動しま

す。ビューアは、OBWIまたはRCSソフトウェアから起動できます。バーチャル・メ

ディア・クライアントでは、ユーザーがローカル・ドライブをターゲット・サーバーのバー

チャル・ドライブにマッピングすることができます。

RCSソフトウェアからバーチャル・メディアを起動するには：

1 ソフトウェアからビューアを起動します。詳細については、「ビューアの使用

法」 (ページ 65) を参照してください。

2 Tools → Virtual Mediaを順に選択します。

3 このセッションを予約に指定したい場合は、バーチャル・メディア・ウィンドウ

でDetailsをクリックした後、Reservedチェック・ボックスをオンにします。

ターゲット・サーバーには、フロッピー／フラッシュ・ドライブとCD/DVDドライブの2種
類のデバイスをマップできます。バーチャル・メディア・クライアントでは、それぞれ1つ
を同時にマップできます。また、バーチャル・メディア・クライアントでは、フロッピーの

イメージ・ファイル( *.img)やCDのイメージ・ファイル( *.iso)をバーチャル・デバイス

にマップすることも可能です。

バーチャル・メディア・インターフェイスは、フロッピー・ドライブ、CD/DVDドライブ、

ステータスという3つの区分で構成されています。バーチャル・メディア・セッション

がKVMセッションにロックされると、バーチャル・メディア・クライアント画面の右上に

ロック状態を示すアイコンが表示されます。

バーチャル・メディア・ドライブのマッピング

バーチャル・メディア・ドライブをマッピングするには：



102xxx | ビューアの使用法xxx

1 ビデオ・ビューアのツールバーからTools → Virtual Mediaを選択して、バー

チャル・メディア・セッションを開始します。

2 物理ドライブをバーチャル・メディア・ドライブとしてマッピングするには、以下の

手順で行います：

a. バーチャル・メディア・ウィンドウで、マップしたいドライブの横のMapped
チェック・ボックスをオンにします。

b. マップするドライブを読み取り専用アクセスに制限したい場合は、ドライ

ブのマッピングを開始する前にRead Onlyチェック・ボックスを選択しておき

ます。マップされたドライブすべてが読み取り専用に既に設定されている

場合は、このチェック・ボックスにはチェック印がついており、これを変更す

ることはできません。

セッションが読み取り／書き込み可能に設定されていて、特定

のドライブへのアクセスを読み取り専用に制限したい場合に

は、Read Onlyチェック・ボックスを選択して設定を変更すること

ができます。

3 ISOまたはディスク・イメージをバーチャル・メディア・ドライブとして追加／マッピ

ングするには、以下の手順で行います：

a. バーチャル・メディア・ウィンドウで、Add Imageをクリックします。

b. Common File Chooserウィンドウが開き、ディスク・イメージ・ファイル( .iso
または.imgの拡張子 )を含むディレクトリが表示されます。ISOまたはディ

スク・イメージ・ファイルを選び、Openをクリックします。

c. 確認のため、ファイル・ヘッダにはチェック印がつきます。チェック印がつい

ていればCommon File Chooser ウィンドウは閉じられ、選択したイメー

ジ・ファイルがバーチャル・メディア・ウィンドウ内に開きます。マップ済み

チェック・ボックスを選択すると、このウィンドウからイメージ・ファイルをマッピ

ングできます。

d. 他にもISOやフディスク・イメージを追加したい場合は、手順a～cを繰り

返します。イメージ・ファイルは(メモリーの容量範囲内で)いくつでも追

加できますが、バーチャルのDVD-ROMまたは大容量記憶装置は同

時に1つしかマッピングできません。
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多過ぎる数のドライブ( DVDドライブ1つと大容量記憶装置1
つ)、あるいは多過ぎる特定タイプ・ドライブ( 1つのDVDドライブ

または大容量記憶装置より多く)をマッピングしようとすると、メッ

セージが表示されます。さらに新しいドライブをマッピングしたい

場合には、まず現在マッピングされているドライブのマッピングを

解除してから、別のドライブをマッピングしてください。物理ドライ

ブまたはイメージをマッピングすると、ターゲット・デバイスで使用

できるようになります。

バーチャル・メディア・ドライブのマッピングを解除するには：

マッピングされたドライブをターゲット・デバイスから取り外します。Mappedチェック・

ボックスの選択を解除します。

バーチャル・メディアの接続ステータス

ステータスの区分には、バーチャル・メディアの接続に関する情報が表示されま

す。現在確立されている接続がない場合は、各欄に「No connection」または

「n/a」と表示されます。

バーチャル・メディア・ドライブの状態を表示するには、以下の手順で行います：

1 バーチャル・メディア・ウィンドウで、Detailsをクリックします。ウィンドウが拡張さ

れ、「詳細」表が表示されます。各行の情報は、次のとおりです：

• Target Drive － ターゲット・サーバーに接続されているバーチャル・デバイ

ス

• Connected To － バーチャル・デバイスに接続されているローカル・ドライ

ブの名前

• Read Bytes － ターゲット・サーバーがローカル・デバイスから読み取ったバ

イト数

• Write Bytes － ターゲット・サーバーがローカル・デバイスに書き込んだバ

イト数

• Duration － ドライブをマッピングしてから経過した時間。

2 「詳細」表示を閉じるには、Detailsを再度クリックします。
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バーチャル・メディア・セッション

バーチャル・メディア・セッションは、2つのUSB接続が単一ケーブルを介して確立さ

れるときに開始されます。これらの接続は、コンピューター上でUSB CD／DVDド

ライブまたはUSB大容量記憶装置として認識されます。バーチャル・メディア・セッ

ションの設定には、ロック状態、マップされたドライブへのアクセス、暗号化レベル

があります。

• Locked - 特定のKVMセッションに関連付けられたバーチャル・メディア・セッ

ション。KVMセッションを閉じると、バーチャル・メディア・セッションが終了しま

す。(例えば、KVMセッションがプリエンプトされた場合、ユーザーによって閉

じられた場合、またはスクリーン・セーバーが起動して停止した場合、関連

付けられたバーチャル・メディア・セッションがアプライアンスによって自動的に

終了します)。ただし、ロック状態のバーチャル・メディア・セッションを終了して

も、対応するKVMセッションは終了しません。

• Mapped drive access - このアクセス・モードは読み取り専用に設定できま

す。アクセス・モードが読み取り専用の場合、クライアント・コンピューター上の

マップされたドライブにはデータの書き込みはできません。アクセス・モードが読

み取り専用になっていなければ、マップされたドライブに対する読み取りと書

き込みが可能になります。マップされるドライブが設計上読み取り専用 (特
定のCDドライブやDVDドライブ、ISOイメージなど)の場合には、読み取

り／書き込みの両方可能に設定されていても無視されます。読み取り専

用に設定しておくと、大容量記憶装置や外付けUSBメディアのような読み

取り／書き込み対応ドライブをマップした後に、誤って上書きされることを回

避できます。

• Encryption level - バーチャル・メディア・セッションでは、最大3つの暗号化レ

ベルを構成できます。どの組み合わせでも有効です。選択肢に

は、AES、DES、3DES、および128ビットRC4( ARCFOUR) SSL暗号化があ

ります。設定されている最も高位のレベルが使用されます。デフォルト設定

は暗号化なしです(暗号化レベルが選択されていません)。

バーチャル・メディア・セッションの予約

バーチャル・メディア・セッションを予約して、指定したユーザー名または管理者の

みがセッションにアクセスしたり、セッションを終了したりするようにできます。KVM
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セッションを閉じた後もバーチャル・メディア・セッションを続行したい場合は、バー

チャル・メディア・セッションを予約できます。予約したバーチャル・メディア・セッショ

ンは、関連付けられたKVMセッションが閉じてもアクティブに維持されます。

バーチャル・メディア・セッションを予約するには：

バーチャル・メディア・ウィンドウで、Detailsをクリックし、Reserveチェック・ボックスを

選択します。

USBバスのリセット

USBリセット機能は、ターゲット・デバイス上のすべてのUSBメディア(マウスおよび

キーボードを含む)をリセットします。この操作を実行するのはターゲット・デバイス

が応答しない場合のみに限定してください。

USBバスをリセットするには：

1 バーチャル・メディア・ウィンドウで、Detailsをクリックします。

2 USB Resetを選択します。

バーチャル・メディア・セッションの終了

バーチャル・メディア・ドライブを終了するには以下の手順で行います：

1 ExitまたはXをクリックし、ウィンドウを閉じます。

2 マップしたドライブがある場合は、マップが解除される旨のメッセージが表示さ

れます。マップを解除するにはYesをクリックしてウィンドウを閉じ、マップの解

除をキャンセルするにはNoをクリックしてウィンドウを閉じます。

ロック状態のバーチャル・メディア・セッションに関連付けられているアクティブ

なKVMセッションを接続解除しようとすると、バーチャル・メディアのマッピングが終

了になることを告げる確認メッセージが表示されます。

バーチャル・メディアとUSB2の制限

Remote Console Switchのバーチャル・メディア機能により、接続されているデバイ

スのUSBポートへの接続が可能になります。この機能を使用することにより、ス

イッチの場所にいるまたはRCSソフトウェアを使用しているユーザーは、接続され

ているコンピューターからUSBのCD／DVD-ROMドライブ、ディスク・ドライブまた
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はFLASHドライブなどのローカルUSBストレージ・デバイスにアクセスすることができ

ます。

USB2 SIPは、キーボード、マウス、DVDドライブ、大容量記憶装置の4つの機

能に対応する複合デバイスです。CD／DVDドライブと大容量記憶装置は、

バーチャル・メディア・セッションがマップされているかどうかに関係なく、ターゲット・デ

バイスに表示されます。メディア・デバイスがマップされていない場合は、メディアな

しの状態で表示されます。バーチャル・メディアがターゲット・デバイスにマップされ

ていると、メディアが挿入されたことがターゲット・デバイスに通知されます。メディ

ア・デバイスのマップが解除されると、メディアが取り外されたことがターゲット・デバ

イスに通知されます。このため、USB2バーチャル・デバイスは、ターゲット・デバイス

から接続解除されません。

USB2 SIPケーブルは、キーボードとマウスを複合USB2 デバイスとして表示しま

す。このため、BIOSで複合USB 2.0ヒューマン・インターフェイス・デバイス( HID)を
サポートしている必要があります。接続されたコンピューターのBIOSがこの種のデ

バイスをサポートしない場合は、オペレーティング・システムにUSB 2.0デバイス・ド

ライバーが読み込まれるまで、キーボードとマウスが作動しない可能性がありま

す。この場合、USB 2.0接続のキーボードとマウスに対するBIOSサポートを含

むBIOSアップデートがコンピューター・メーカーから提供されていることがあります。

バーチャル・メディアを使用したコンピューターの起動

多くの場合、このバーチャル・メディアの機能によって、接続されているコンピュー

ターをスイッチのUSBポートに取り付けられているデバイスから起動することができ

ます。USBポートを有する大部分のコンピューターではバーチャル・メディアを使用

できますが、USBメディア・デバイスおよびシステムBIOSの一部に見られる制限に

より、Remote Console Switchに取り付けられているUSBデバイスからコンピュー

ターを起動することができない場合があります。

バーチャルUSBデバイスからの起動は、ターゲット・デバイスが外付けの複合USB
デバイスからの起動をサポートするかどうかによって決まります。また、外付

けUSB2.0による起動をサポートするオペレーティング・システムのCD／DVDが必

要です。以下は、外付けUSB2.0デバイスによる起動をサポートするオペレーティ

ング・システムの一部の一覧です：

• Windows Server 2003

• Windows XP
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• Windows 2000 Server( Server Service Pack( SP4)以降 )

使用コンピューターでバーチャル・メディアから起動ができるかどうかを判定するに

は、以下の手順に従ってください。

1 起動可能な状態になっているオペレーティング・システムのインストー

ルCD／DVDを挿入したUSB CD／DVD-ROMドライブをRemote Console
Switchに接続して、それをターゲット・デバイスにマッピングします。ターゲット・

デバイスを再起動して、取り付けたCD／DVDドライブから起動するかどう

かを指定します。外付けUSBデバイスから起動するには、BIOSを設定する

必要がある場合があります。

2 ターゲット・デバイスが起動しない場合は、ターゲット・デバイスのUSBポート

にUSB CD／DVDドライブを接続して、ターゲット・デバイスを再起動しま

す。ターゲット・デバイスがCD／DVDドライブから正常に起動する場合は、

そのBIOSは複合USB 2.0デバイスからの起動をサポートしていません。ター

ゲット・デバイスのメーカーのサポートWebサイトを閲覧して、複合USB 2.0デ
バイスからの起動をサポートする最新版のBIOSが利用できるかどうかを判断

してください。利用できる場合は、BIOSを更新して、手順をもう一度行いま

す。

3 ターゲット・デバイスが外付けUSB 2.0デバイスから起動できない場合は、以

下の方法を使用してそのターゲット・デバイスをリモートで起動します。

• BIOSバージョンの一部では、USB速度を制限するオプションが提供され

ています。このオプションが利用可能な場合は、USBポートの設定を

「USB 1.1」または「Full Speed」モードに変更してもう一度起動してみてく

ださい。

• USB 1.1カードを挿入してもう一度起動してみてください。

• USB 1.1ハブをUSB2ケーブルとターゲット・デバイスの間に挿入して、もう

一度起動してみてください。

• 複合USB 2.0デバイスからの起動をサポートするBIOSバージョンを現在

利用できるか、または更新の予定があるかどうかの情報を、ターゲット・

デバイスのメーカーに問い合わせてください。
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付録 A：RCSソフトウェアの更新

システムを最適な状態で運用していただくため、RCSソフトウェアの最新版

をDellサポートWebサイト(dell.com/support)で入手されていることをご確認くださ

い。

RCSソフトウェアを更新するには：

1 DellサポートWebサイト(dell.com/support)から、アップデート・ファイルをダウ

ンロードします。

2 インストーラをダブルクリックします。インストーラが、ご使用のシステムに以前

のバージョンのRCSソフトウェアがインストールされているかどうかをチェックしま

す。

3 前のバージョンが検出されず、更新を確認するダイアログ・ボックスが表示さ

れた場合は、Continueをクリックします。

-または-
以前のバージョンが検出され、その製品の別のバージョンがあることを警

告するダイアログ・ボックスが表示された場合は、Overwriteをクリックし

て、アップグレードすることを確認します。

-または-
Cancelをクリックし、ソフトウェアをアップグレードせずに終了します。

4 インストールが開始します。プログラム・ファイル、ショートカット、環境変数、

レジストリ・エントリ( Win32システムのみ)がインストールされるか、現バージョ

ンの新しいファイルと設定で上書きされます。
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注： アップグレード検出プロセスが正しく機能するようにするためには、最初に再起
動まはたログアウトを実行する必要があります。インストーラにより設定されるレジス
トリ・キーは、システムからログアウトするかシステムを再起動するまで、Win32プラット
フォームまたはLinux上で永続的に設定されたことにはなりません。
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付録 B：キーボードとマウス

操作 説明

F6キー
分割画面間で操作し、最後にフォーカスがあったアイテムへフォーカ

スを戻す。

F8キー フォーカスをディバイダーに向ける。

左向き／上向

き矢印キー
フォーカスがディバイダーにある場合、ディバイダーを左に移動する。

右向き／下向

き矢印キー
フォーカスがディバイダーにある場合、ディバイダーを右に移動する。

Homeキー
フォーカスがディバイダーにある場合、分割画面の右側ペインが領域

全体にわたって表示される( 左側ペインは表示されない) 。

Endキー
フォーカスがディバイダーにある場合、分割画面の左側ペインが領域

全体にわたって表示される( 右側ペインは表示されない) 。

クリック＋マウス

ドラッグ
ディバイダーを右または左に移動する。

表 B.1：分割画面でのキーボードとマウスのショートカット
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操作 説明

マウスのシング

ルクリック

既存の選択を解除し、マウスポインターが位置するノードを選択

する。

マウスのダブ

ルクリック

拡張可能なノード ( 子を持つノード ) の拡張／縮小ステータスをト

グルで切り替える。リーフノード ( 子を持たないノード ) 上では機能

しない。

上向き矢印

キー

既存の選択を解除し、それまで選択されていた項目のすぐ上の

ノードを選択する。

下向き矢印

キー

既存の選択を解除し、それまで選択されていた項目のすぐ下にあ

るノードを選択する。

スペースキー 現在の選択項目を交互に選択／選択解除する。

Enterキー

現在の選択項目を交互に縮小／拡大する。子を持つノードにの

み適用する。リーフノード ( 子を持たないノード ) 上では機能しな

い。

Homeキー 既存の選択を解除し、ルートノードを選択する。

Endキー 既存の選択を解除し、ツリー表示の最後のノードを選択する。

表 B.2：ツリー表示コントロール・キーボードとマウスのショートカット

操作 説明

Enterキーまた

はReturnキー
選択されたユニットのデフォルト動作を起動する。

上向き矢印

キー
現在の選択を解除し、一行上を選択する。

表 B.3：ユニット・リストでのキーボードとマウス操作
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操作 説明

下向き矢印

キー
現在の選択を解除し、一行下を選択する。

Page Upキー
現在の選択を解除し、一頁上へスクロールしてその頁の最初の

アイテムを選択する。

Page Down
キー

現在の選択を解除し、一頁下へスクロールしてその頁の最後の

アイテムを選択する。

Deleteキー
削除機能を実行する。Edit-Deleteメニュー機能と同じ働きをする。

詳しい情報についていは、当該セクションを参照。

Ctrl＋Home
キー

表の最初の行にフォーカスを移動し、これを選択する。

Ctrl＋Endキー 表の最後の行にフォーカスを移動し、これを選択する。

Shift＋上向き

矢印キー
選択領域を一つ上の行まで拡大する。

Shift＋下向き

矢印キー
選択領域を一つ下の行まで拡大する。

Shift＋Page Up
キー

選択領域を前のページまで拡大する。

Shift＋Page
Downキー

選択領域を次のページまで拡大する。

Shift＋マウ

ス・クリック

マウスをクリックした時点で既存の選択をすべて解除し、現在の

フォーカスポイントとマウスのポインターがある行の間の行範囲を選

択する。
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操作 説明

Ctrl＋マウス・ク

リック

マウス・ポインターが位置する行の選択状態を、他の行の選択状

態に影響を与えることなく、トグルで切り替える。

マウスのダブ

ルクリック
選択されたユニットのデフォルト動作を起動する。
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付録 C：TCPポート

次の表は、Remote Console Switchによって実行される機能と、使用されるポー

トの一覧です。

ポート 機能

TCP 80/443 デフォルトのHTTP/HTTPSです。

TCP 2068
ビデオ・ビューア・ビデオ、キーボード、マウス、ユーザー認証、バーチャ

ル・メディアに使用されます。

TCP/UDP 3211 管理とインストール／検出に使用されます。

表 C.1：使用されるポート

注： TCP/IPポートは固定されており、変更できません。

注： ポート2068と3211のデータはすべて、Secure Socket Layer( SSL) プロトコルを使用
して暗号化されています。

注： 1081ADと2161ADスイッチの場合は、TCP 2068およびTCP/UDP 3211ポートをサポート
するためにRAKが必要です。
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付録 D：テクニカル・サポート

Dell製品のインストールや操作について問題や疑問点が生じた場合には当社

のテクニカル・サポートまでご連絡ください。担当スタッフがお手伝いいたします。

万一問題が生じた場合は、より良いサービスをお受けいただけるよう、次の手

順に従ってください。

問題を解決するには：

1 問題の該当箇所をマニュアルで調べ、記載されている手順に従って解決で

きるかどうかを試してください。

2 弊社のWebサイト(dell.com/support)にある「Knowledge Base(ノレッジ・ベー

ス)」のデータベースからご検索いただくか、あるいは「Online Service Request
(オンライン・サービス・リクエスト)」をご利用ください。

3 最寄りのDellテクニカル・サポートまでお電話にてご連絡ください。
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